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This License Agreement details the policy for license of AdventNet ManageEngine OS Deployer 
(Licensed Software) on the following topics:  
 
Evaluation License 
 
Commercial License 
 
Technical Support 
 
Please read the following license carefully, before either (i) completing the electronic order or 
download of the Licensed Software from an authorised website, or (ii) installing the Licensed Software 
from media that was delivered after being ordered by alternative order process, as applicable. You 
acknowledge that you have read this License Agreement, have understood it, and agree to be bound 
by its terms without any change. If you do not agree to the terms and conditions of this Agreement, 
either (i) exit the web site page without continuing the ordering process, or (ii) return the provided 
unused media and documentation within thirty (30) days from the date of shipment of the Licensed 
Software for a full refund of your payment, as applicable. 
 
1. Evaluation License 
 
AdventNet grants to you a non-exclusive, non-transferable, Evaluation License for trial and evaluation 
of the Licensed software, in binary object code form, for a period of thirty (30) days from the date of 
download or installation. This License begins upon downloading or installing the Licensed Software and 
ends thirty (30) days thereafter ("Evaluation Period").  
 
If you are not willing to use the Licensed Software, after the Evaluation Period, delete all the copies 
installed in your computer with immediate effect. You are forbidden from using the Licensed Software 
for any other use or otherwise offering it for resale under the terms of this Section 1. AdventNet 
retains all rights not specifically granted to you herein. 
 
2. Commercial License 
 
AdventNet grants you a fee-bearing, nonexclusive, non-transferable, perpetual, world-wide license to 
Use the Licensed Software, including user documentation that you have downloaded from or received 
on media provided by AdventNet and all updates, where applicable, provided that such access and Use 
of the Licensed Software is in accordance with the Single Installation License granted by AdventNet.  
 
"Use" means storing, locating, installing, executing or displaying the Licensed Software.  
 
"Single Installation License" means that one copy of the Licensed Software may not be installed on 
more than one machine. 
  
3. Third Party Products 
 
The Licensed Software may contain software which originated with third party vendors and without 
limiting the general applicability of the other provisions of this Agreement, you agree that (a) the title 
to any third party software incorporated in the Licensed Software shall remain with the third party 
which supplied the same; and (b) you will not distribute any such third party software available with 
the Licensed Software, unless the license terms of such third party software provide otherwise. 
 
4. Restrictions on Use  
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In addition to all other terms and conditions of this Agreement, you shall not: 
 
(i) install one copy of the Licensed Software on more than one CPU;  
(ii) remove any copyright, trademark or other proprietary notices from the Licensed Software or its 
copies; 
(iii) make any copies except for one back-up or archival copy, for temporary emergency purpose; 
(iv) rent, lease, license, sublicense or distribute the Licensed Software or any portions of it on a 
standalone basis or as part of your application;  
(v) modify or enhance the Licensed Software;  
(vi) reverse engineer, decompile or disassemble the Licensed Software. 
(vii) allow any third parties to access or use the Licensed Software. 
(viii) provide any service to third parties using the Licensed Software. 
(ix) make copies, or verbal or media translations, of the user’s guide.  
(x) make telecommunication data transmission of the software. 
 
5. Technical Support  
 
AdventNet provides support that includes email support for problem reporting, product updates, 
upgrades and online access to product documentation during the period for which a valid maintenance 
and support contract exists. Technical Support is not included as part of perpetual license. You may 
purchase technical support services for perpetual license by paying the then current maintenance and 
support fee. 
 
6. Ownership and Intellectual Property  
 
AdventNet owns all right, title and interest in and to the Licensed Software. AdventNet expressly 
reserves all rights not granted to you herein, notwithstanding the right to discontinue or not to release 
any Licensed Software and to alter prices, features, specifications, capabilities, functions, licensing 
terms, release dates, general availability or characteristics of the Licensed Software. The Licensed 
Software is only licensed and not sold to you by AdventNet.  
 
7. Audit  
 
AdventNet has the right to audit your Use of the Licensed Software by providing at least seven (7) 
days prior written notice of its intention to conduct such an audit at your facilities during normal 
business hours. 
 
8. Confidentiality  
 
The Licensed Software contains proprietary information of AdventNet that are protected by the laws of 
the United States and you hereby agree to take all reasonable efforts to maintain the confidentiality of 
the Licensed Software. You agree to reasonably communicate the terms and conditions of this 
Agreement to those persons employed by you who come into contact with or access the Licensed 
Software, and to use reasonable efforts to ensure their compliance with such terms and conditions, 
including but not limited to, not knowingly permitting such persons to use any portion of the Licensed 
Software for a purpose that is not allowed under this Agreement.  
 
9. Warranty Disclaimer  
 
AdventNet does not warrant that the Licensed Software or its functions will meet your requirements or 
that the operation of the software will be uninterrupted or error-free or that any defects will be 
corrected. Except as provided herein, the Licensed Software is furnished "as is" without warranty of 
any kind, including the warranties of merchantability and fitness for a particular purpose and without 
warranty as to the performance or results you may obtain by using the Licensed Software. You are 
solely responsible for determining the appropriateness of using the Licensed Software and assume all 
risks associated with the use of it, including but not limited to the risks of program errors, damage to 
or loss of data, programs or equipment, and unavailability or interruption of operations. 
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10. Limitation of Liability  
 
In no event will AdventNet or its licensors be liable to you or any third party for any special, incidental, 
indirect, punitive or exemplary or consequential damages, or damages for loss of business, loss of 
profits, business interruption, or loss of business information arising out of the use or inability to use 
the program or for any claim by any other party even if AdventNet has been advised of the possibility 
of such damages. AdventNet's entire liability with respect to its obligations under this agreement or 
otherwise with respect to the Licensed Software shall not exceed the amount of the named developer 
license fee paid by you for the Licensed Software. 
 
11. Indemnification  
 
AdventNet agrees to indemnify and defend you from and against any and all claims, actions or 
proceedings, arising out of any claim that the Licensed Software infringes or violates any valid U.S. 
patent, copyright or trade secret right of any third party; so long as you provide; (i) prompt written 
notice to AdventNet of such claim; (ii) cooperate with AdventNet in the defense and/or settlement 
thereof, at AdventNet's expense; and, (iii) allow AdventNet to control the defense and all related 
settlement negotiations. The above is AdventNet's sole obligation to you and shall be your sole and 
exclusive remedy pursuant to this Agreement for intellectual property infringement.  
 
AdventNet shall have no indemnity obligation for claims of infringement to the extent resulting or 
alleged to result from (i) any combination, operation, or use of the Licensed software with any 
programs or equipment not supplied by AdventNet; (ii) any modification of the Licensed Software by a 
party other than AdventNet; and (iii) your failure, within a reasonable time frame, to implement any 
replacement or modification of Licensed Software provided by AdventNet. 
 
12. Termination 
 
This Agreement is effective until terminated by either party. You may terminate this Agreement at any 
time by destroying or returning to AdventNet all copies of the Licensed Software in your possession. 
AdventNet may terminate this Agreement for any reason, including but not limited to your breach of 
any of the terms of this Agreement. Upon termination, you shall destroy or return to AdventNet all 
copies of the Licensed Software and certify in writing that all known copies have been destroyed. All 
provisions relating to confidentiality, proprietary rights, non-disclosure, and limitation of liability shall 
survive the termination of this Agreement.  
 
13. General 
 
This Agreement shall be construed, interpreted and governed by the laws of the State of California 
exclusive of its conflicts of law provisions. Any dispute arising out of or resulting from this Agreement 
shall be subject to the jurisdiction of courts in Alameda County, California and the parties waive any 
objection in respect of inconvenience thereof. This Agreement constitutes the entire agreement 
between the parties, and supersedes all prior communications, understandings or agreements 
between the parties. Any waiver or modification of this Agreement shall only be effective if it is in 
writing and signed by both parties hereto. If any part of this Agreement is found invalid or 
unenforceable, the remainder shall be interpreted so as to give reasonable effect to the intention of 
the parties. You shall not export the Licensed Software or your application containing the Licensed 
Software except in compliance with United States export regulations and applicable laws and 
regulations. 
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1.  Introducing ManageEngine® OS Deployer 
 
 
 
This chapter gives a general idea of how an IT department can meet various real life challenges using 
the ManageEngine OS Deployer. 
 

1.1  Overview 

1.1.1  What is ManageEngine OS Deployer? 
 
ManageEngine OS Deployer is a flexible, efficient software solution for deployment of a fully 
configured operating system (with or without application software and any other data) to multiple 
computers. Because the product uses disk imaging technology, it is ideal for rapid bare-metal 
installations and flexible centralized provisioning. 
 

1.1.2  Who needs  ManageEngine OS Deployer? 
 
ManageEngine OS Deployer is primarily designed to be used by:  

Small and medium-size businesses:  
- IT service providers  
- Hardware retailers 
IT departments of larger corporations    
Schools and universities 
R&D and software testing labs. 

 
The enterprise features added to ManageEngine OS Deployer (scheduled deployment, support for 
Preinstallation Environment, command line and scripting, to name a few) can help automate the tasks 
of the IT department in large enterprise environments. 
 

1.1.3  ManageEngine OS Deployer infrastructure 
 
Components of the ManageEngine infrastructure are installed on Windows computers. Centralized 
imaging, deployment and managing the ManageEngine infrastructure is performed using 
ManageEngine Snap Deploy Management Console.  
 
A reference image can be taken either in Windows or in the ManageEngine or Windows PE 
environment. The ManageEngine environment provides the GUI mode. Under Windows PE, command 
line mode and scripting are supported.  
 
Deployment is performed in the ManageEngine or Windows PE environment.  
 
A dedicated bootable utility enables full functional deployment with GUI on a standalone computer (a 
computer isolated from the network or included in a network without ManageEngine OS Deployer 
infrastructure.) 
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1.2  What you can do with ManageEngine OS Deployer 
 

1.2.1  Take an image of the master system 
 
First, you create the desired system configuration and save the image of the system hard disk on a 
network share, detachable or removable media. Image is a file that contains the system in a packaged 
form.  
 
Scenarios: 
 

1. Usually, company departments, such as accounting, sales or technical support, use a fixed set 
of applications for daily work. Capture an entire library of images and deploy them to new 
hardware without having to manually configure the operating system and applications. 

 
2. The administrator might need to deploy a standard configuration included in the library on 

various hardware. The separately sold ManageEngine OS Deployer option can configure 
Windows system drivers so that Windows is able to boot on dissimilar hardware. Without this 
option the motherboard, processors and mass storage devices of the imaged and the target 
hardware must be identical. The same applies to non-Windows operating systems. 

 

1.2.2  Manual deployment 
 
Boot the target computers (the computers to deploy to) into ManageEngine environment using 
ManageEngine bootable media or ManageEngine PXE (Preboot eXecution Environment) Server. Set up 
and save parameters of the deployment operation (the deployment template.) 
 
Launch the deployment. The program multicasts the image to the computers you specified and 
deploys the system on their hard disks. DNS names, domain or workgroup membership, TCP/IP 
settings, user accounts and security identifiers are assigned on the fly according to the settings you 
made.  
 
Once the deployment is completed, the computers boot up from their hard disks. The program can 
shut down or restart the computers according to the settings you made. Sometimes you will have to 
complete configuration of devices, otherwise the computers are ready to work. (Activation of the 
operating system is needed though.) 
 

1.2.3  Scheduled deployment  
 
Deployment can be run on a schedule. 
 
Scheduling presumes that when the scheduled time comes, the program will power on the target 
computers with predefined MAC addresses using the BIOS Wake On LAN (WOL) functionality.  
 
Computers in other subnets can be woken through a WOL proxy agent delivered with ManageEngine 
OS Deployer.  
 
Computers that do not support WOL can be booted into ManageEngine environment manually before 
the scheduled time comes. Such computers will also be deployed provided that their MAC addresses 
are included in the total list. 
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Scenarios: 
 

1. An organization receives a shipment of computers from a manufacturer along with the list of 
their MAC addresses. The IT department has to deploy the operating system to the new 
hardware. 

 
2. An Internet café, school or university lab has 100 computers with known MAC addresses. The 

nightly deployment of the initial standard image on these computers is needed.  
 

1.2.4  Event-driven deployment 
 
Deployment can be run when the predefined number of computers is ready. The program counts how 
many computers have connected to the deployment server and starts multicasting when the 
predefined number of computers is connected.  
 
The administrator can specify a time-out period. On time-out, deployment will start on the computers 
that are ready despite that the predefined number is not reached. 
 
Scenario: 
 

1. An organization receives 100 computers from a manufacturer. The IT department has to 
deploy systems, preconfigured according to the employees’ roles, to the predefined number of 
computers. For example, 10 computers for accountants, 10 computers for the marketing 
department, 70 computers for sales and 10 for the managers. 

 

1.2.5  Command line and scripting under Win PE  
 
ManageEngine OS Deployer provides a command line utility that can be added to a Windows 
Preinstallation Environment (Win PE) image. The administrator uploads the customized PE image to a 
PXE server or transfers the PE image onto removable media. 
 
Having booted a machine in the Preinstallation Environment, the administrator can perform imaging or 
deployment in the command line mode or execute scripts. 
 
Using ManageEngine OS Deployer in Windows Preinstallation Environment allows a combination of 
both the products facilities and provides more functionality than using only-ManageEngine bootable 
media. The following scenarios can be implemented using ManageEngine OS Deployer command line 
and Win PE. 
 
Scenarios: 
 

1. The administrator might need to deploy diverse images on each of the networked computers. 
 
The administrator writes a deployment script that can read the target’s MAC address (for example, 01-
02-03-04-05-06) and pull an image with a name corresponding to the MAC address (for example, 
image-01-02-03-04-05-06.tib) from any convenient location. The script can be executed on any 
number of targets.  
 

2. The administrator might need to start imaging or deployment automatically each time a 
networked computer boots from the PXE server. 

 
The administrator creates an imaging or deployment script, adds the script to the PE and includes the 
script in the startnet.cmd file. On booting into the PE, the operation will be performed automatically. 
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3. The administrator might need to automatically execute pre-deployment operations (disk 

partitioning, for example) on the networked computers. 
 
The administrator creates a script that performs pre-deployment operations, adds the script along with 
deployment script to the PE and includes both scripts in the startnet.cmd file. On booting into the PE, 
both operations will be performed automatically. 
 

4. The administrator might need to execute imaging or deployment in Win PE environment if the 
ManageEngine environment lacks Linux drivers for some exotic hardware. 

 
Limitation: 

 
ManageEngine OS Deployer command line utility can generate a new SID but cannot adjust 
other settings on the fly. To change the computer name, domain or workgroup membership 
and other settings, apply the Microsoft System Preparation Tool (Sysprep) to the master 
system and specify the new settings in the Sysprep.inf answer file. 
 

1.2.6  Standalone deployment  
 
The administrator might need to deploy on a computer isolated from a network or included in a 
network without ManageEngine OS Deployer infrastructure. A dedicated bootable utility enables full 
functional deployment with GUI on a standalone computer.  
 
The ManageEngine Universal Deploy option is not available in the standalone mode. 
 

1.2.7  Custom Deployment (User-initiated deployment)  
 
ManageEngine OS Deployer can be configured in such a way that users will be able to deploy and re-
deploy their computers with one click on the boot menu.  
 
Scenarios: 
 

1. Software testers have to deploy clean operating systems or preconfigured systems on test 
machines. A test team leader creates custom bootable media or a PXE package that provides a 
fixed set of choices on the target side. A test team member reboots a test computer and 
selects what to deploy from the boot menu with one click. The deployment starts immediately. 

 
The choices can be various operating systems, various editions of the same operating system, 
the same operating system with various settings or various applications, to name a few. The 
deployment proceeds independently on each computer. 

 
2. The same scenario fits in a university or school lab when switching between exercises requires 

reconfiguring the computer entirely. Students can switch or restart exercises without the 
teacher’s assistance. 

 
If a student messes up the machine (deletes a file, changes configuration, etc.) then he/she 
could choose a self-restore option from the boot menu.  

 
The custom deployment mode is intended for continual work without the administrator’s assistance. 
Once the mode is set, other methods of deployment (manual, scheduled, event-driven deployment) 
become unavailable. Any scheduled task that has to start while the custom deployment mode is on, 
will not start. Only users (the ones on the target side) can initiate deployment. However, the 
administrator can view logs, create new deployment templates, change the custom deployment 
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configuration (add, edit or remove boot menu items) and perform other management operations 
except for deployment. 
 
To initiate deployment on the console side, the administrator switches off the custom deployment 
mode. 
 

1.2.8  Deployment of a disk partition or MBR  
 
You do not necessarily have to deploy the entire disk. Provided the master and the target disks have a 
similar partitioning scheme, you can image and deploy only the system partition or only the data, 
depending on your needs. 
 
ManageEngine OS Deployer can image and deploy the Master Boot Record (MBR).  
 

1.2.9  Selective deployment (MAC filtering)  
 
ManageEngine OS Deployer has the ability to disable deployment on computers with specified MAC 
addresses. This protects production servers and user’s systems from unfortunate events. The program 
can import the access list from a text file. Both straight (enabling) and inverse (disabling) lists are 
supported. 
 
Scenario: 
 

1. Let’s say, a networked computer boots up from PXE by mistake. The new image then might be 
deployed on the computer by an event-driven operation or by the PE configured to start 
deployment upon booting. The original data will be lost. 

 

1.2.10  Password protection  
 
Images taken with ManageEngine OS Deployer can be protected with a password to prevent 
unauthorized deployment. 
 
ManageEngine OS Deployer also supports password protected images created with the Acronis True 
Image products family.  
 
To prevent ManageEngine bootable components from unauthorized execution, the ManageEngine boot 
menu can also be protected with a password. 
 

1.2.11  Manage a remote computer  
 
An administrator can perform operations on a remote computer using ManageEngine OS Deployer.  
 
File management: Create and edit text files (for example batch files or scripts), copy files/folders to 
the clipboard, paste them, rename and delete files and folders. 
 
Applications management: Execute service applications (configuration files, scripts) on a remote 
computer by scheduling tasks. The scheduled task contains the application to execute and when the 
application will be run. 
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1.3  What is new? 

1.3.1  Encrypted communication 
 
ManageEngine OS Deployer components communicate to each other using the Secure Sockets Layer 
(SSL) cryptographic protocol. Encryption starts on the first (earliest) stage of connection attempt, so 
all data transferred in the next steps (including data required for client authentication) is encrypted.  
 
Once ManageEngine OS Deployer components are installed, encrypted communication between the 
components is enabled automatically. The deploy stream, being transferred via the communication 
protocol, is not encrypted. 
 

1.3.2  Multicast TTL and network bandwidth throttling 
 
Deployment configuration has a parameter that specifies time to live (TTL) for multicast packets. Using 
this setting, you can limit the distribution of multicast packets via gateways.  
 
By setting the permitted bandwidth you can limit the network usage during deployment. 
 

1.4  Supported operating systems 
 
ManageEngine OS Deployer provides full-featured imaging and deployment of the following operating 
systems: 
 
 Deployment Change 

settings 
License 
type* 

MS Windows Server 2008 (TBD) Yes Yes S 
MS Windows Server 2003 Service Pack 2 (x86, x64) Yes Yes S 
MS Windows Server 2003 R2 (x86, x64) Yes Yes S 
MS Windows Small Business Server 2003 Yes Yes S 
MS Windows Storage Server 2003 R2 Yes Yes S 
MS Windows Server 2003 x64 Editions Yes Yes S 
MS Windows 2000 Server Yes Yes S 
MS Windows 2000 Advanced Server Yes Yes S 
MS Windows 2000 Professional SP4 Yes Yes S 
MS Windows Vista Home Basic (x86, x64) Yes Yes WS 
MS Windows Vista Home Premium (x86, x64) Yes Yes WS 
MS Windows Vista Business (x86, x64) Yes Yes WS 
MS Windows Vista Ultimate (x86, x64) Yes Yes WS 
MS Windows XP Home Yes Yes WS 
MS Windows XP Professional  Yes Yes WS 
MS Windows XP Professional x64 Edition Yes Yes WS 
MS Windows XP Professional SP2  Yes Yes WS 
MS Windows NT/4.0 Server Yes No S 
MS Windows 98/Me Yes No WS 
Linux (kernel: 2.4.9 – 2.6.x) Yes No S 
* - S – server license, WS – workstation license.   
 
ManageEngine OS Deployer enables, with certain limitations (some operations or options will not be 
available), imaging and deployment of any PC-based operating system. For example, Windows 
98/NT/ME, NT/4.0 Server, Linux (kernel: 2.4.9 – 2.6.x) can be deployed only as is, on-the-fly settings 
adjustment is not performed. 
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The ManageEngine Universal Deploy option is not applicable to Windows 98/NT/ME and NT/4.0 
Server. 
 

1.5  License policy 
 
ManageEngine OS Deployer licensing is based on the number of deployed and/or managed computers 
(servers or workstations.) For example, to deploy a system on 100 computers you need 100 
deployment licenses. No additional licenses are required to manage the deployed computers or re-
deploy any of them. 
 

1.5.1  Server and workstation licenses 
 
ManageEngine OS Deployer has two types of licenses. A license for the server product is needed to 
deploy a server operating system or install the management agent on a server operating system. A 
license for the workstation product is needed to deploy a workstation operating system or install the 
management agent on a workstation operating system.  
 
A workstation license is needed to deploy a disk or partition that does not contain an operating 
system, if the target computer has not been assigned a license before. 
 
Linux is considered as a server OS. The explicit list of server and workstation operating systems is in 
the previous section. 
 
If ManageEngine OS Deployer fails to identify the type of operating system, the operating system is 
considered as a workstation OS. 
 
A server license could be used instead of a workstation license automatically or through a prompt. 
 

1.5.2  Licenses for ManageEngine Universal Deploy 
 
ManageEngine Universal Deploy is an add-on to ManageEngine OS Deployer and has its own serial 
numbers and license agreement.  
 
The ManageEngine Universal Deploy licenses are counted, used and upgraded in the same way as the 
ManageEngine OS Deployer licenses. ManageEngine Universal Deploy also has two types of licenses 
for server and workstation operating systems. You need one Universal Deploy license per target 
computer. 
 
You do not need a license to install ManageEngine Universal Deploy. However, do not forget to add 
the ManageEngine Universal Deploy licenses to the license server before starting deployment. If the 
licenses are not found during deployment, the ManageEngine Universal Deploy step will be skipped. 
 

1.5.3  ManageEngine OS Deployer trial version 
 
The ManageEngine OS Deployer trial version has all the functionality of the standard version. To 
upgrade from the trial version to the standard product you do not need to re-download the software. 
Simply buy the licenses and import them to the license server. 
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1.6  Technical support 
 
As part of a purchased annual Support charge you are entitled to Technical Support as follows: to the 
extent that electronic services are available, you may electronically access at no additional charge, 
Support services for the Software, which ManageEngine shall endeavor to make available twenty four 
(24) hours a day, seven (7) days per week. Such electronic services may include, but are not limited 
to: user forums; software-specific information; hints and tips; bug fix retrieval via the internet; 
software maintenance and demonstration code retrieval via a WAN-accessible FTP server; and access 
to a problem resolution database via ManageEngine customer support system. 
 
Support shall consist of supplying telephone or other electronic support to you in order to help you 
locate and, on its own, correct problems with the Software and supplying patches, updates and other 
changes that ManageEngine, at its sole discretion, makes or adds to the Software and which 
ManageEngine makes generally available, without additional charge, to other licensees of the Software 
that are enrolled in Support. Upon mutual agreement by both parties, ManageEngine shall: (i) supply 
code corrections to you to correct Software malfunctions in order to bring such Software into 
substantial conformity with the published operating specifications for the most current version of the 
Software unless your unauthorized modifications prohibit or hamper such corrections or cause the 
malfunction; or (ii) supply code corrections to correct insubstantial problems at the next general 
release of the Software.   
 
More information about contacting ManageEngine Technical Support is available at the following link: 
http://osdeployer.com/support.html. 
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2.  Understanding ManageEngine OS Deployer 
 
 
This chapter describes the ManageEngine OS Deployer infrastructure components and their 
interaction.  
 

2.1  Terminology 
 
The following table lists the common terms and descriptions used in this document. 
 
Master system The system to be deployed. 

 
Master image 
(Image) 
 

A file that contains the master system in a packaged form. The file has a 
“.tib” extension. 
 

Online imaging Taking an image while the master system is in a production state (the 
operating system is running on the master computer.) 
 

Offline imaging Taking an image while the master computer is booted into ManageEngine 
or Windows preinstallation environment. 
 

Deployment Transferring the operating system (OS), applications and data from the 
master image file to a physical hard disk. In most cases, deployment is 
performed by multicasting the image through the network. 
 

Standalone 
deployment 

Deployment on a computer isolated from a network or included in a 
network without ManageEngine OS Deployer infrastructure. Standalone 
deployment is performed locally using the bootable ManageEngine OS 
Deployer component. 
 

Target disk The physical disk to be deployed to (an internal hard disk of the target 
computer.) 
  

Target computer 
(Target) 
 

The hardware to be deployed to.  
 

Deployment 
template 
(Template) 

Configuration parameters of the deployment operation: 
1. Path to the master image 
2. The operation mode (multicast or unicast, how to handle the target disk 
free space etc.) 
3. Settings to be applied to the deployed systems (DNS names, user 
accounts etc.) 
4. Operations to be performed on the deployed systems (transfer files, 
execute applications, shut down, restart) 
 
Once you save a deployment template, you can use it in the future. 
 

Administrator 
 

The person who has rights to manage ManageEngine OS Deployer 
infrastructure.  
 

Custom 
deployment 
mode 

The mode when deployment can be initiated on the target side only. 
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User 
 

The person on the target side who initiates the custom deployment. This 
term relates to the custom deployment mode only.  

2.2  Components 
 
ManageEngine OS Deployer includes the following components: 
 
1. ManageEngine OS Deployer Management Console is an administrative tool for remote 

access to ManageEngine servers and ManageEngine OS Deployer Management Agent. 
 
When disconnected from the ManageEngine components, the console allows only installing 
ManageEngine products on remote machines. 

 
2. ManageEngine OS Deploy Server is a component that performs centralized deployment 

through the network with the help of ManageEngine OS Deployer Agents. 
  
3. ManageEngine OS Deployer Agent is a bootable component that performs deployment on 

each target computer under control of the ManageEngine OS Deploy Server.  
 

There are two ways to load ManageEngine OS Deployer Agent on target computers: locally from 
bootable media or remotely using ManageEngine PXE Server. 

 
4. ManageEngine Master Image Creator is a bootable, locally controlled component that takes 

an image of the master system.  
 

There are two ways to load ManageEngine Master Image Creator on a master computer: directly 
from bootable media or remotely using ManageEngine PXE Server. 

 
5. ManageEngine OS Deployer Management Agent is a component that takes an image of the 

master system in Windows environment under the administrator’s control through the 
ManageEngine OS Deployer Management Console. The administrator can also manage files and 
execute applications on a remote computer using ManageEngine OS Deployer Management Agent. 

 
6. ManageEngine PXE Server allows for network booting computers into ManageEngine OS 

Deployer Agent, ManageEngine Master Image Creator or Preinstallation Environment. The 
computers must support PXE. Using ManageEngine PXE Server considerably reduces the time 
required for booting multiple computers as compared to using bootable media. It also eliminates 
the need to have a technician onsite to install the bootable media into the system that must be 
booted. 

 
7. ManageEngine Wake on LAN Proxy is a component that enables the ManageEngine OS Deploy 

Server to wake the target computers located in the other subnet. 
 
8. ManageEngine Standalone Utility is a bootable component that enables full functional 

deployment with GUI on a standalone computer (a computer isolated from the network or 
included in a network without ManageEngine OS Deployer infrastructure.)  

 
9. ManageEngine License Server is a component that tracks licenses of ManageEngine products.  
 
10. ManageEngine Universal Deploy (optional) is an add-on to ManageEngine OS Deployer that 

enables hardware-independent operating system deployment. 
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2.3  Support for file systems and storage media 

2.3.1  Supported file systems 
 
ManageEngine OS Deployer provides full-featured imaging and deployment of the following file 
systems: 
- FAT16/32 
- NTFS 
- Ext2/Ext3 
- ReiserFS 
- Reiser4 
- Linux SWAP 
- XFS 
- JFS 
 

2.3.2  Supported media 
 
ManageEngine Master Image Creator can save an image: 
- on a network share 
- on the master computer internal hard drive 
- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached to the 

master computer 
- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the master computer media drive.  
 
A sizeable image can be split between multiple media automatically.  
 
ManageEngine OS Deploy Server can deploy images located:  
- in network shared folders 
- on the deploy server internal hard drive 
- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached to the 

deploy server  
- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the deploy server media drive.  
 
The best practice is keeping images on the deploy server hard drive. This minimizes network traffic 
during deployment.  
 
The image created on removable media has to fit into one media disk. To deploy an image spread 
over several CDs, DVDs or other media, copy all parts of the image to the same folder on the deploy 
server or on a network share. 
 
ManageEngine Standalone Utility can deploy images located:  
- in network shared folders 
- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached to the 

managed computer  
- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the managed computer media drive.  
 
The image created on removable media has to fit into one media disk. To deploy an image spread 
over several CDs, DVDs or other media, copy all parts of the image to the same folder on an external 
drive or a network share. 
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2.4  Usage 
This section gives a general idea of using the product and does not contain the detailed instructions on 
how to perform operations. Nevertheless, advanced users are welcome to use this section as a step-
by-step quick start guide. The details can be found in the further User’s Guide sections. 

2.4.1  Offline imaging 
 
Offline imaging means that the master system is stopped and the master computer boots into 
ManageEngine (or PE) environment. 
 
1. Configure the master system. 

2. Install ManageEngine OS Deployer Management Console.   

3. Do one of the following: 

Create bootable media with ManageEngine Master Image Creator (or PE with ManageEngine OS 
Deployer command line utility) 

or 

Install ManageEngine PXE Server, connect the console to the PXE server and upload ManageEngine 
Master Image Creator (or PE with ManageEngine OS Deployer command line utility.)  

4. Do one of the following, depending on your choice in step 3: 

Boot the master computer into ManageEngine Master Image Creator (or PE) from bootable media 

or 

Boot the master computer into ManageEngine Master Image Creator (or PE) from the PXE Server. 

5. On the master computer, follow the Create Image Wizard instructions to configure and launch the 
imaging operation (or perform imaging in PE using ManageEngine command line). The image can 
be saved on a network share, detachable or removable media. To access the network from a 
bootable environment, you must have a DHCP server or configure the master computer network 
settings manually. 
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Offline imaging 
 

2.4.2  Online imaging 
 
Online imaging means that the master system is imaged live (without reboot or suspending 
operations.) Online imaging can be performed remotely whenever you need. The disadvantage is that 
you have to install imaging software that (1) takes a license and (2) is included in the master image. 
This is not always rational.  
 
1. Configure the master system. 

2. Install ManageEngine OS Deployer Management Console and ManageEngine License Server. 
Import licenses to the license server. 

3. Install ManageEngine OS Deployer Management Agent on the master system locally or remotely, 
using ManageEngine OS Deployer Management Console. This will take a license from the license 
server. Reboot on prompt. Once ManageEngine OS Deployer Management Agent is installed, you 
can image the master system online (without reboot) at any time. 

4. Connect the console to the master system, click Create Master Image -> Next -> Create master 
image on a remote computer. Follow the Create Image Wizard instructions to configure and 
launch the imaging operation. The image can be saved on a network share, detachable or 
removable media. 
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Online imaging 

 

2.4.3  Deployment 
 
The following illustrates the ManageEngine components functionality by the example of manual 
deployment. During event-driven and scheduled deployment the components perform similarly. 
 
Deployment presumes that you have created a master image, so at least the ManageEngine OS 
Deployer Management Console is installed.   
 
1. Install ManageEngine License Server. Import licenses to the license server. Install ManageEngine 

OS Deploy Server. 

2. Do one of the following: 

Create bootable media with ManageEngine OS Deployer Agent (or PE with ManageEngine OS Deployer 
command line utility) 

or 

Install ManageEngine PXE Server, connect the console to the PXE server and upload ManageEngine OS 
Deployer Agent (or PE with ManageEngine OS Deployer command line utility.) 

3. Do one of the following, depending on your choice in step 2: 

Boot the target computer(s) into ManageEngine OS Deployer Agent (or PE) from bootable media 

or 

Boot the target computer(s) into ManageEngine OS Deployer Agent (or PE) from the PXE Server. 

You must have a DHCP server or configure the target computers network settings manually to enable 
the target computers to connect to ManageEngine OS Deploy Server.  

4. Do one of the following, depending on whether the agent or the PE is running: 

- Connect the console to the ManageEngine OS Deploy Server. Select the Deployment tab 
- Make sure that the target computers IP addresses are displayed on the Deployment tab. This 

means that the computers are connected and ready for deployment  
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- Click Manual Deployment and follow the Manual Deployment Wizard instructions to configure and 
launch the deployment operation 

or  

- perform deployment in PE using ManageEngine command line utility. 

 

 
 

 
Manual deployment 

 

2.5  What is ManageEngine Universal Deploy 
 
This section describes the ManageEngine proprietary technology that helps deploy and boot up 
Windows on dissimilar hardware. ManageEngine Universal Deploy saves you from configuring a new 
master system for each make of hardware you have to deploy on. 
 
If you plan to deploy Windows on multiple computers that are identical to each other, but differ from 
the master computer hardware; deploy the master image on one of the identical computers using 
ManageEngine Universal Deploy. This will adjust Windows to the dissimilar hardware. Then image the 
adjusted system and deploy it to the identical computers. 
 
The ManageEngine Universal Deploy option is not available in the standalone mode. 
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2.5.1  ManageEngine Universal Deploy purpose 
 
A system disk image can be deployed easily on the hardware where it was created or to identical 
hardware. However, if you change a motherboard or use another processor version, the deployed 
system could be unbootable. An attempt to transfer the system to a new, much more powerful 
computer will usually produce the same unbootable result because the new hardware is incompatible 
with the most critical drivers included in the image. 
 
Using Microsoft System Preparation Tool (Sysprep) does not solve this problem, because Sysprep 
permits adding drivers only for Plug-and-Play devices (sound cards, network adapters, video cards 
etc.). As for the system Hardware Abstraction Layer (HAL) and mass storage device drivers, they must 
be identical on the source and the target computers (see Microsoft Knowledge Base, articles 302577 
and 216915). 
 
ManageEngine Universal Deploy technology provides an efficient solution for hardware-independent 
system deployment by adding the crucial Hardware Abstraction Layer (HAL) and mass storage device 
drivers.  
 

2.5.2  ManageEngine Universal Deploy general principles 
 
1. Automatic HAL and mass storage drivers selection 
ManageEngine Universal Deploy searches the Windows default driver storage folders (in the image 
being deployed) for HAL and mass storage device drivers and installs drivers that better fit the target 
hardware. You can specify a custom driver repository (a folder or folders on a network share or CD) 
which will also be used for drivers search. 
 

 

The Windows default driver storage folder is determined in the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current version\DevicePath. This 
storage folder is usually WINDOWS/inf. 

 
2. Manual selection of mass storage device driver 
If the target hardware has a specific mass storage controller (such as a SCSI, RAID, or Fibre Channel 
adapter) for the hard disk, you can install the appropriate driver manually, bypassing the automatic 
driver search-and-install procedure. 
 
3. Installing drivers for plug and play devices 
ManageEngine Universal Deploy relies on built-in plug and play discovery and configuration process to 
handle hardware differences in devices that are not critical for the deployed system start-up, such as 
video, audio and USB. Windows takes control over this process during the logon phase, and if some of 
the new hardware is not detected, you will have a chance to install drivers for it later manually. 
 

2.5.3  ManageEngine Universal Deploy and Microsoft Sysprep 
 
ManageEngine Universal Deploy is not a system preparation tool. You can apply it to any system 
image created by ManageEngine products, including images of systems prepared with Microsoft 
System Preparation Tool (Sysprep).  
 

2.5.4  Getting ManageEngine Universal Deploy  
ManageEngine Universal Deploy is an add-on to ManageEngine OS Deployer. It is purchased 
separately, has its own license, and is installed from a separate setup file.  
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3.  Installation 
 

3.1  System requirements 
 
The ManageEngine OS Deployer components can be installed on computers running the following 
operating systems: 
 
 The type of license required for the 

ManageEngine OS Deployer 
Management Agent installation 

MS Windows Server 2008 (TBD) S 
MS Windows Server 2003 Service Pack 2 (x86, x64) S 
MS Windows Server 2003 R2 (x86, x64) S 
MS Windows Small Business Server 2003 S 
MS Windows Storage Server 2003 R2 S 
MS Windows Server 2003 x64 Editions S 
MS Windows 2000 Server S 
MS Windows 2000 Advanced Server S 
MS Windows 2000 Professional SP4 WS 
MS Windows Vista Home Basic (x86, x64) WS 
MS Windows Vista Home Premium (x86, x64) WS 
MS Windows Vista Business (x86, x64) WS 
MS Windows Vista Ultimate (x86, x64) WS 
MS Windows XP Home WS 
MS Windows XP Professional  WS 
MS Windows XP Professional x64 Edition WS 
MS Windows XP Professional SP2  WS 
* - S – server license, WS – workstation license.   
 
 

3.2  Used ports and IP addresses 
 
The ManageEngine OS Deploy Server and the ManageEngine OS Deployer Management Console use 
the following ports and IP addresses for remote operation: 
- UDP port: 9876 
- TCP port: 9876, if busy, choose a port at random 
- IPv4 multicast address: 239.255.219.45 
- ManageEngine OS Deployer Management Console UDP port: 9877, if busy, choose a port at 

random 
 
The ManageEngine PXE Server uses the following ports and IP addresses: 
- UDP port: 67, 68, 69. 
- Broadcast address: 255.255.255.255 
  
For a remote installation, the TCP port 25001 is used.  
 
If you are using a firewall, you might have to set the appropriate access options. 
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3.3  General rules of installation  

3.3.1  Installation file 
 
ManageEngine OS Deployer installation file includes the following components and the components’ 
features: 
ManageEngine OS Deployer Management Console 
 ManageEngine OS Deployer PE Builder 

Media Builder for ManageEngine Image Creator 
 Media Builder for ManageEngine OS Deployer Agent 
 Media Builder for ManageEngine Standalone Utility 
ManageEngine License Server 
 ManageEngine License Server 
 ManageEngine License Server Management Console 
 ManageEngine License Server Management Tool 
ManageEngine OS Deploy Server 
ManageEngine PXE Server 
ManageEngine OS Deployer Management Agent 
ManageEngine WOL Proxy 
 

 
 

The installation window 
 
The ManageEngine Universal Deploy option installs from its own installation file. 
 

3.3.2  Common installation configurations 
 
ManageEngine OS Deployer components can be installed in various configurations, in terms of 
distributing the components and features among the networked computers.  
 
1. The minimal configuration that enables only offline imaging and standalone deployment: 

ManageEngine OS Deployer Management Console (custom installation, including: 
 Media Builder for ManageEngine Image Creator 
 Media Builder for ManageEngine Standalone Utility.) 
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all on the same computer.  
 
 
2. The minimal configuration that enables offline imaging, standalone deployment and 
deployment through the network with ManageEngine OS Deploy Server: 

ManageEngine OS Deployer Management Console (custom installation, including: 
 Media Builder for ManageEngine Image Creator 
 Media Builder for ManageEngine Standalone Utility  
 Media Builder for ManageEngine OS Deployer Agent.) 
ManageEngine License Server (custom installation, includes only: 
 ManageEngine License Server) 
ManageEngine OS Deploy Server 

all on the same computer. On the target computers, no ManageEngine components are required. 
 
 
3. The configuration that adds the network boot of master and target computers to the above 
functionality: 

ManageEngine OS Deployer Management Console (custom installation, including: 
 Media Builder for ManageEngine Image Creator 
 Media Builder for ManageEngine Standalone Utility  
 Media Builder for ManageEngine OS Deployer Agent.) 
ManageEngine License Server (custom installation, includes only: 
 ManageEngine License Server) 
ManageEngine OS Deploy Server 
ManageEngine PXE Server 

all on the same computer. On the target computers, no ManageEngine components are required.  
 
This is the recommended elementary configuration that enables most of the ManageEngine OS 
Deployer functionality. 
 
In case physical access to the powerful server is limited, you can install the console on a separate 
computer. Another common configuration is: 
Workstation: 

ManageEngine OS Deployer Management Console (custom installation, including: 
 Media Builder for ManageEngine Image Creator 
 Media Builder for ManageEngine Standalone Utility  
 Media Builder for ManageEngine OS Deployer Agent.) 

Server:  
ManageEngine License Server(custom installation, includes only: 
 ManageEngine License Server) 
ManageEngine OS Deploy Server 
ManageEngine PXE Server 

 
Generally, you can install all ManageEngine servers on separate computers. In this case, you will have 
to connect the management console to each server separately to manage the server. With all servers 
on one computer, only one console connection is needed.  
 
 
4. To add the ability to deploy Windows on dissimilar hardware to any configuration but (1), 
install the ManageEngine Universal Deploy add-on on a computer where ManageEngine OS 
Deploy Server is installed. 
 
 
5. To add the online imaging ability and the ability to validate images integrity to any 
configuration, install ManageEngine OS Deployer Management Agent. 
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Online imaging means that the master system is imaged live (without reboot or suspending 
operations.) Online imaging can be performed remotely whenever you need on connecting the console 
to the management agent installed on the master computer. The management agent will be included 
in the master image and deployed on all target computers. This will enable you to manage files and 
execute applications on target computers at any time after deployment.  
 
However, having excess software in the master image is not always rational. Besides, installation of 
the agent takes a license.  
 
We recommend that you create a master image using bootable ManageEngine Master Image Creator 
or the command line utility in PE. Nevertheless, having at least one management agent on the 
network (not necessarily on the master computer) makes sense. You will be able to validate (check) 
your images integrity using the management agent.  
 
 
6. To add the ManageEngine OS Deploy Server ability to deploy in other subnet (across a switch) 
to any configuration but (1), install ManageEngine WOL Proxy on any server in the subnet where 
the target computers are. No additional actions are required. 
 
ManageEngine WOL Proxy has to be installed only if:  
- you are going to perform scheduled deployment (manual or event-driven deployment do not 

require WOL Proxy Server) 
AND  
- all or some of the target computers are in subnet(s) other than ManageEngine OS Deploy Server. 
 
 

3.4  Installation of ManageEngine OS Deployer Management Console 
 
ManageEngine OS Deployer Management Console is an administrative tool for remote access to 
ManageEngine servers and ManageEngine OS Deployer Management Agent. Install ManageEngine OS 
Deployer Management Console on any networked computer from which you prefer to operate.  
 
To install ManageEngine OS Deployer Management Console: 
1. Run the ManageEngine OS Deployer setup program 
2. Click Install ManageEngine OS Deployer Management Console  
3. Follow the Install Wizard instructions on the screen. 
 
Typical and complete installations install, besides ManageEngine OS Deployer Management Console, 
Media Builder for ManageEngine Image Creator, Media Builder for ManageEngine OS 
Deployer Agent and Media Builder for ManageEngine Standalone Utility. We strongly 
recommend that you install all the features that enable creation of bootable CD, DVD or other 
removable media with bootable ManageEngine components.  
 
Once ManageEngine OS Deployer Management Console is installed, you can install the other 
components remotely using the console’s remote installation feature (for more information, see 4.2  
Installation and update of ManageEngine components on remote computers). 
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3.5  Installation of ManageEngine License Server 

3.5.1  Installation 
 
ManageEngine License Server is a component that tracks licenses of ManageEngine products. 
Install ManageEngine License Server on a computer accessible to ManageEngine OS Deploy 
Server. Installing both products on the same computer would make sense.  
 
A typical installation installs ManageEngine License Server and the ManageEngine License Server 
Management Console. A complete installation installs, besides these two, ManageEngine License 
Server Management Tool. A custom installation lets you choose components to install.  
 
The ManageEngine License Server Management Tool is a simple command-line utility for 
controlling ManageEngine License Server. ManageEngine License Server Management Console 
provides an easy-to-use GUI. Alternatively, you can control ManageEngine License Server using 
ManageEngine OS Deployer Management Console. So you can choose to install only the 
ManageEngine License Server.  
 

 

If you have already installed ManageEngine License Server that came with another 
ManageEngine product, you still need to install ManageEngine License Server that came with 
ManageEngine OS Deployer. You can install both license servers on the same computer. The 
ManageEngine License Server then will be seen as a common server for all ManageEngine 
products. 
There is no need to install ManageEngine License Server Management Console or 
ManageEngine License Server Management Tool once again, because you already have the 
necessary management instruments.  

 
To install ManageEngine License Server: 
1. Run the ManageEngine OS Deployer setup program 
2. Click Install ManageEngine License Server 
3. Follow the Install Wizard instructions on the screen. 
4. Reboot on prompt. 
After installation, ManageEngine License Server launches automatically as Windows service. 
 
Before installing ManageEngine OS Deploy Server, import serial numbers to ManageEngine License 
Server either in command-line mode or using ManageEngine OS Deployer Management Console. 
 
 

3.5.2  Adding licenses using ManageEngine OS Deployer Management 
Console 
 
1. Run the ManageEngine OS Deployer Management Console. 
2. Click Manage licenses. Connect to the computer where ManageEngine License Server is 

installed. 
3. Click Add License on the sidebar. 
4. In the Add License window, type in the serial number or a path to the .txt or .eml file containing 

the serial numbers. Or you can browse to the file. 
5. In the final window, click Proceed. ManageEngine License Server performs the operation and 

reports the number of newly-added licenses. 
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The license server has 10 server licenses 
 

3.5.3  Adding licenses in command line mode 
 
If you have installed ManageEngine License Server Management Tool, you can add licenses to the 
ManageEngine License Server in the command line mode. 
 
1. Run cmd.exe (Windows Command Prompt) 
2. Go to the folder where ManageEngine License Server is installed. By default, it is    

\Program Files\OSDeployer\LicenseServer 
3. Enter the following command: 
 
LicenseServerCmdLine --import-file [servername] [filename] 
where: 
servername – name of the computer where ManageEngine License Server is installed 
filename – name of the file (*.txt or *.eml) with the serial numbers 
 
Example: 
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This will add the serial numbers from C:\ManageEngineEnglish.txt to the license server Ltest-2. 
  
 
 

3.6  Installation of ManageEngine OS Deploy Server 
 
ManageEngine OS Deploy Server is a component that performs centralized deployment through 
the network with the help of ManageEngine OS Deployer Agents. 
 
Before installing ManageEngine OS Deploy Server, you need to install the ManageEngine License 
Server and import license numbers to it (for more information see the previous section). 
 
To install ManageEngine OS Deploy Server: 
1. Run the ManageEngine OS Deployer setup program 
2. Click Install ManageEngine OS Deploy Server  
3. Follow the Install Wizard instructions on the screen.  
4. Reboot on prompt. 
 
The wizard will ask you for ManageEngine License Server. Browse to the server, or enter its name 
or IP address, or let the server be found automatically on the network. This will not decrease the 
number of deployment licenses. The program just checks the availability of the licenses and stores the 
specified ManageEngine License Server parameters to be able to access the ManageEngine License 
Server later, when the deployment is launched. 
 

3.7  Installation and setup of ManageEngine PXE Server 
 
ManageEngine PXE Server allows the network booting of the ManageEngine OS Deployer Agent, 
ManageEngine Master Image Creator or Preinstallation Environment on target computers. Using 
ManageEngine PXE Server considerably reduces the time required for booting the computers as 
compared to using bootable media. It also eliminates the need to have a technician onsite to install 
the bootable media into the system that must be booted. This allows for unattended scheduled 
deployment. 
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Using ManageEngine PXE Server makes sense if there is a Dynamic Host Control Protocol (DHCP) 
server in your network, so that the booting computers can automatically get IP addresses. Without 
DHCP, you can boot computers from PXE, but have to configure their network settings manually. 
 
We recommend that you have only one PXE server within a subnet to ensure predictability of the 
booting computers behavior. 
 

3.7.1  Installation of ManageEngine PXE Server 
 
To install ManageEngine PXE Server: 
1. Run the ManageEngine OS Deployer setup program 
2. Click Install ManageEngine PXE Server  
3. Follow the on screen Install Wizard instructions.  
 
ManageEngine PXE Server runs as a service immediately after installation. Later on it will automatically 
launch at each system restart. You can stop and start this program in the same way as other services. 
 

3.7.2  Setting up a computer to boot from PXE 
 
For bare metal, it is enough that the machine’s BIOS supports network booting.  
 
On a machine that has an operating system on the hard disk, the BIOS must be configured so that the 
network interface card is either the first boot device, or at least prior the Hard Drive device. The 
example below shows one of reasonable BIOS configurations. If you don’t insert bootable media, the 
computer will boot from the network. 
 

 
 

Setting up the BIOS (example) for network boot 
 
In some BIOS versions, you have to save changes to BIOS after enabling the network interface card 
so that the card appears in the list of boot devices. 
 
If the hardware has multiple network interface cards, make sure that the card supported by the BIOS 
has the network cable plugged in. 
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3.7.3  Setting up PXE and DHCP on the same server 
 
If ManageEngine PXE Server and the DHCP server are on the same computer, add to the DHCP 
server option 60: “Client Identifier” with string value “PXE Client”.  This can be done as follows: 

C:\WINDOWS\system32>netsh 
netsh>dhcp 
netsh>dhcp>server \\<server_machine_name> or <IP address> 
netsh dhcp>add optiondef 60 PXEClient STRING 0 comment=”Option added for 
PXE support” 
netsh dhcp>set optionvalue 60 STRING PXEClient 
 

3.7.4  Setting up the PXE to work in other subnet 
 
To enable the ManageEngine PXE Server to work in other subnet (across the switch), configure the 
switch to relay the PXE traffic. The PXE server IP addresses are configured on a per-interface basis 
using IP helper functionality in the same way as DHCP server addresses. For more information please 
refer to: 
http://support.microsoft.com/default.aspx/kb/257579 
 

3.8  Installation of ManageEngine WOL Proxy 
 
ManageEngine Wake on LAN Proxy enables the ManageEngine OS Deploy Server to wake the 
target computers located in the other subnet. 
 
ManageEngine WOL Proxy has to be installed only if:  
- you are going to perform scheduled deployment (manual or event-driven deployment do not 

require WOL Proxy) 
AND  
- all or some of the target computers are in subnet(s) other than ManageEngine OS Deploy Server. 
 
Install ManageEngine WOL Proxy on any server in the same subnet as the target computers. No 
additional actions are required. 
 
To install ManageEngine WOL Proxy Server: 
1. Run the ManageEngine OS Deployer setup program 
2. Click ManageEngine WakeOnLAN Proxy  
3. Follow the Install Wizard instructions on the screen.  
 
ManageEngine WOL Proxy runs as a service immediately after installation. Later on it will automatically 
launch at each system restart. You can stop and start this program in the same way as other services. 
 

3.9  Installation of ManageEngine OS Deployer Management Agent 
 
Installation of ManageEngine OS Deployer Management Agent adds the online imaging ability 
and the ability to validate integrity of your images. 
 
Online imaging means that the master system is imaged live (without reboot or suspending 
operations.) Online imaging can be performed remotely whenever you need on connecting the console 
to the management agent installed on the master computer. The management agent will be included 
in the master image and deployed on all target computers. This will enable you to manage files and 
execute applications on target computers at any time after deployment.  
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However, having excess software in the master image is not always rational. Besides, installation of 
the agent takes a license.  
 
We recommend that you create a master image using bootable ManageEngine Master Image Creator 
or the command line utility in PE. Nevertheless, having at least one management agent on the 
network (not necessarily on the master computer) makes sense. You will be able to validate (check) 
your images integrity using the management agent.  
 
To install ManageEngine OS Deployer Management Agent: 
 
1. Run the ManageEngine OS Deployer setup program 
2. Click Install ManageEngine OS Deployer Management Agent  
3. Follow the Install Wizard instructions on the screen 
4. The wizard will ask you for ManageEngine License Server. Browse to the server, or enter its 

name or IP address, or let the server be found automatically on the network.  
 

There must be at least one ManageEngine OS Deployer license of appropriate type on the license 
server. A license for the server product is needed to install the agent on a server operating 
system. A license for the workstation product is needed to install the agent on a workstation 
operating system. A server license can be used instead of a workstation license through a prompt. 
The management agent installation will decrease the number of free licenses by one. 
 

5. Reboot on prompt.  
 

3.10  Installation of ManageEngine Universal Deploy 
 
ManageEngine Universal Deploy is an add-on to ManageEngine OS Deployer. It is purchased 
separately and installed from a separate setup file.  
 
ManageEngine Universal Deploy can be installed only on a computer where ManageEngine OS Deploy 
Server is installed. 
 
ManageEngine Universal Deploy can be installed on a networked computer either locally, by running 
the setup program, or remotely. To install ManageEngine Universal Deploy remotely, extract the setup 
file (.msi) to a network share (see below) and install ManageEngine Universal Deploy in the same way 
as other ManageEngine OS Deployer components (see 4.2  Installation and update of ManageEngine 
components on remote computers). 
 
After installation ManageEngine Universal Deploy automatically plugs in ManageEngine OS Deploy 
Server. 
 

 

You do not need a license to install ManageEngine Universal Deploy. However, do not forget 
to add the ManageEngine Universal Deploy licenses to the license server before starting 
deployment. If the licenses are not found during deployment, the ManageEngine Universal 
Deploy step will be skipped. 

 
 

3.11  Extracting the ManageEngine OS Deployer components  
During ManageEngine OS Deployer Management Console installation, all ManageEngine OS Deployer 
components’ setup (.msi) files will be placed in the \Program Files\Common 
Files\OSDeployer\RemoteInstall folder. Thus, you will be able to remotely install, modify or repair the 
components using ManageEngine OS Deployer Management Console or msiexec.exe utility. 
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When installing ManageEngine OS Deployer components on a local computer, you can save setup files 
for each component separately on a local or network drive. This will help when modifying or 
recovering the existing component installation on a local computer. 
 
To save a component’s setup file: 
1. Run the ManageEngine OS Deployer setup file 
2. In the Install Menu, right-click on the component name and select Extract 
3. Select a location for the setup file and click Save. 
 
 

3.12  Using ManageEngine License Server 
 
This section does not describe steps of the installation procedure. It contains general information 
necessary for understanding ManageEngine License Server and covers more operations with licenses 
than described in 3.5.2  Adding licenses using ManageEngine License Server Management Console and 
3.5.3  Adding licenses in command line mode.  
 

3.12.1  Understanding ManageEngine License Server 
 
The ManageEngine License Server is a mechanism that tracks licenses of ManageEngine products. 
ManageEngine OS Deployer licensing is based on the number of deployed and/or managed computers 
(servers or workstations). For example, to deploy a system on 100 computers you need 100 
deployment licenses. No additional licenses are required to manage the deployed computers or re-
deploy any of them.  
 
ManageEngine Universal Deploy is an add-on to ManageEngine OS Deployer and has its own serial 
number and license agreement. 
 
ManageEngine License Server tracks the licenses using a MAC address, which is unique for each 
network interface card (NIC). Although a MAC address is usually hardwired to the NIC, some operating 
systems offer a way to change it. It is important to note that attempting to change the MAC address 
on a system may impede the ManageEngine License Server operation and prevent you from other 
deployments to the same computer or from managing that computer remotely. 
 
When installing ManageEngine OS Deploy Server, you have to specify the ManageEngine License 
Server. Once the ManageEngine License Server is found the program checks for available licenses on 
the server and stores its net address to be able to access the ManageEngine License Server later, 
when deployment is launched. 
 
When starting a deployment, ManageEngine OS Deploy Server checks the availability of free licenses 
on the ManageEngine License Server. If there are enough free licenses for the deployment, the 
process will run and the number of free licenses will decrease by the number of deployed systems. 
 
ManageEngine License Server can import multiple license numbers from .txt or .eml files, saving you 
from the time-consuming procedure of typing in each number. 
 
When upgraded, recovered or reinstalled, the ManageEngine License Server keeps all the imported 
licenses intact. However, it is recommended that you copy the file(s) with license numbers to 
removable media, or create a hard copy of that file(s) and keep it in a safe place. This ensures that 
you have license data available in case of hardware failure. 
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3.12.2  Viewing information about licenses  
 
1. Run the ManageEngine OS Deployer Management Console. 
2. Click Manage licenses. Connect to the computer where ManageEngine License Server is 

installed. This will display all serial numbers available on the ManageEngine License Server. One 
serial number can contain multiple licenses. 

 

 
 

You have 10 server licenses and 5 workstation licenses 
 
Right-click on the column headings bar to choose the details to display: Product Name, Serial Number, 
Import Date, Expiration Date and Total number of licenses assigned to each serial number, as well as 
how many of them are available (i.e. free) and used. For example, if one license corresponds to one 
serial number, Total=1, Available=1, Used=0 (if the license is free) or Available=0, Used=1 (if the 
license has been allocated.) 
 
3. To display more information about used licenses, select Manage Used Licenses on the sidebar. 

(This item does not appear while all licenses are free.) 
 
The Used mode lists all licenses that are allocated. Right-click on the column headings bar to choose 
the details to display: Product Name, Host Name, Host Address, Serial Number, Acquire Date (date of 
deployment or installation that used the license) and Renewal Date (the latter is not valid for 
ManageEngine OS Deployer licenses). 
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Two licenses are used 
 
You can sort any list using View -> Arrange Icons by. 
 

3.12.3  Removing licenses  
 
To completely remove a license from the ManageEngine License Server, select it from the list of 
available licenses and click Remove License on the sidebar.  
 

3.12.4  Using the ManageEngine License Server Management Tool 
 
The ManageEngine License Server Management Tool is a command-line utility for controlling 
ManageEngine License Server. The LicenseServerCmdLine.exe file installs with only the 
ManageEngine License Server complete installation. The tool is located in the installation folder, by 
default it is \Program Files\OSDeployer\LicenseServer. If the file is not found, install it by running the 
ManageEngine OS Deployer setup program. For more information, see 3.5  Installation of 
ManageEngine License Server. 

  
LicenseServerCmdLine.exe uses the following syntax: 
 
LicenseServerCmdLine [command] [option1] [option2] 
 
LicenseServerCmdLine.exe supports the following commands and command options: 
 
--list 
Displays the list of ManageEngine License Servers found on the local network. 
 
--status [servername or server IP-address] 
Displays the status of the specified License Server, i.e. the number of total/free licenses for each 
ManageEngine product.  
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--import [servername] [serial key] 
Adds information about a new license (new serial key). You can specify multiple serial numbers (space 
separated).  
 
--import-file [servername] [filename] 
Imports license serial keys from .txt or .eml file. 
 
--help 
Shows usage. 
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4.  Using ManageEngine OS Deployer Management Console 
 

4.1  Connections 

4.1.1  Connect to a local machine 
 
When started, ManageEngine OS Deployer Management Console connects to the local machine if there 
is a manageable ManageEngine OS Deployer component on this machine. You can manage any 
ManageEngine server or ManageEngine OS Deployer Management Agent installed on the same 
machine without any additional actions. 
 

 
 

The management console home window 
 

4.1.2  Connect to another computer 
 
ManageEngine OS Deployer Management Console can connect to any networked computer where an 
ManageEngine server or ManageEngine OS Deployer Management Agent is installed. Once connected, 
you can manage the ManageEngine server or perform operations using the ManageEngine OS 
Deployer Management Agent. To connect to any ManageEngine component you need the 
administrator’s privileges on the remote machine. 
 
Manage Deployment – connect to ManageEngine OS Deploy Server.  
Create Master Image – connect to ManageEngine OS Deployer Management Agent (or start 
ManageEngine Media Builder) 
Check master image – connect to ManageEngine OS Deployer Management Agent 
Create Bootable media with ManageEngine OS Deployer Agent – connection is not needed 
Manage Licenses – connect to ManageEngine License Server 
Install ManageEngine components – connection is not needed 
Configure ManageEngine PXE Server – connect to ManageEngine PXE Server 
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Manage files – connect to ManageEngine OS Deployer Management Agent 
Execute Applications - connect to ManageEngine OS Deployer Management Agent. 
 

4.2  Installation and update of ManageEngine components on remote 
computers 
 
The following components of ManageEngine OS Deployer can be installed remotely: 
- ManageEngine OS Deploy Server 
- ManageEngine License Server 
- ManageEngine PXE Server 
- ManageEngine WOL Proxy 
- ManageEngine OS Deployer Management Agent.   
 

 

ManageEngine OS Deployer components cannot be installed onto remote computers running 
Windows Vista and Windows Server 2008. Please install the components locally on such 
machines. 

 
Preparation 
 
For a successful installation on a remote computer running any Windows XP version, the option 
Control panel -> Folder options -> View -> Use simple file sharing must be disabled on that 
computer. 
 
For a successful installation on a remote computer running Windows XP with Service Pack 2 or 
Windows 2003 Server, the option Control panel -> Windows Firewall -> Exceptions -> File and 
Printer Sharing in the Control panel -> Windows Firewall -> Exceptions must be enabled on 
that computer. 
 
ManageEngine OS Deployer utilizes TCP port 25001 for a remote installation. Make sure this port 
added to exceptions in your firewall settings.  
 
Installation 
 
1. Click Install ManageEngine components. 
 
2. Select the installer location from the list (Registered Components, Search removable media 
or Specify location). The default selection Registered Components will use setup files from the 
default C:\Program Files\Common Files\OSDeployer\RemoteInstall folder. 
 
3. Select the ManageEngine component and specify the component features you want to install (for 
component features see 3.3  General rules of installation). 
  
4. Browse to the remote computer or specify its network name or IP address.  
 
5. Enter the administrator’s username and password for the remote machine. 
 
6. Specify the ManageEngine License Server, if the wizard asks. You must have at least one free 
license on the license server to install ManageEngine OS Deploy Server or ManageEngine OS Deployer 
Management Agent. 
 
7. Installation of some ManageEngine components requires system restart. If you allow immediate 
remote computer reboot, check the Reboot the remote computer box. 
 
8. Click Proceed. 
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The ManageEngine component then will be installed on the remote computer. If system restart is 
necessary, the remote machine will reboot or the program will prompt you to restart the remote 
machine, depending on your choice in step 6. 
 
To update an ManageEngine component on a remote computer, perform the same procedure. 
 
 
 

4.3  Browsing logs 
 
To view operation logs of the ManageEngine OS Deploy Server or ManageEngine PXE Server, connect 
the console to the server. Logs are displayed in the lower part of the console window. 
 
The log browsing window can be accessed by selecting Tools -> Show log. 
 
The log browsing window contains two panes: the left one features the log list, while the right one 
shows selected log contents. 
  
The left panel can contain up to 50 logs. If there are more, you can browse the list using the More 
and Less buttons with the left and right arrows. 
 
To delete a log, select it and click Delete. 
 
If any step was terminated by an error, the corresponding log will be marked with a red circle with a 
white “X” inside. 
 
The right window features the list of steps contained in the selected log. The three buttons to the right 
control message filters: the white “X” in the red circle filters error messages, the exclamation sign in a 
yellow triangle filters warnings, and the “i” in the blue circle filters information messages. 
 
To select columns (step parameters) to display, right-click the headers line or left-click the Choose 
Details button. Then check the desired parameters. 
 
To sort messages by a particular parameter, click its header (click again to reverse order) or the 
Arrange Icons by button (the second from the right) and select the desired parameter. 
 
You can also change column width by dragging the borders with a mouse. 

5.  Creating ManageEngine bootable media 
 
ManageEngine OS Deployer has three bootable components that can boot and perform operations on 
any PC-compatible hardware, including bare metal and computers with non-supported file systems. 
The components are:  
- ManageEngine OS Deployer Agent (boots on a target computer to enable deployment 

performed by ManageEngine OS Deploy Server) 
- ManageEngine Standalone Utility (boots on a target computer and performs deployment on 

its own) 
- ManageEngine Master Image Creator (boots on a master computer and takes an image of the 

system.) 
 
A computer can be booted into a bootable component using physical media or ManageEngine PXE 
Server. 
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ManageEngine bootable media is a physical media (CD, DVD, USB flash drive, diskettes or other media 
supported by the computer BIOS as a boot device) that contains bootable components of 
ManageEngine OS Deployer.  
 
ManageEngine PXE Server with uploaded bootable components can also be thought of as a kind of 
bootable media. That’s why you can create bootable media or configure the PXE server using the same 
wizard. 
 
To start the bootable media builder, select from the start menu ManageEngine -> ManageEngine 
OS Deployer Management Console -> Bootable Media Builder. You can also run the Bootable 
Media Builder from the ManageEngine OS Deployer Management Console window (click Create 
Bootable Media on the toolbar or the sidebar, or select Create Bootable Media from the Tools 
menu.) 
 
1. Select bootable components to be placed on the media. 
 

 
 

Selecting bootable components 
 
Select the component that will start automatically (such component is also referred as the default 
boot menu item) and specify the timeout interval for the component automatic start. If you 
choose, say, ManageEngine OS Deployer Agent, and set the Start automatically after 
parameter to 10 sec, the agent will launch 10 seconds after the boot menu is displayed. You also 
have the options: 
 
No auto start - the ManageEngine loader will display the boot menu and wait for someone to 
select whether to boot the OS or one of the ManageEngine components. 
 
Booting from HDD – the operating system, if present on the booting computer’s hard disk, will 
start after the specified time runs out. This option is designed to make the target computer to 
boot into the deployed OS after deployment. The main usage scenario is as follows. 
 

You create a PXE package for scheduled deployment and configure the ManageEngine OS Deployer 
Agent to start automatically. After the scheduled deployment is completed, the target computer 
reboots into the agent again and might be deployed by some other deployment operation. How to 
avoid this situation?  
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To ensure that the target computer boots into the agent before the deployment, tune the PXE Server 
to work with your deployment server when scheduling the deployment. To ensure that the target 
computer boots into the deployed OS after the deployment, choose the Booting from HDD option 
when creating the PXE package for the scheduled deployment.  
 

 

ManageEngine Standalone Utility can be placed on a physical media only. This component is 
not designed to boot from a PXE server. 

 
2. ManageEngine OS Deployer Agent can be configured to connect to a specified deployment server. 

This setting allows you to have multiple deployment servers that perform different functions on 
the same network.  
 
The deployment server (along with the agent network interface settings) can be specified also 
onsite when booting up the agent. To be able to enter the agent configuration onsite, set up a 
reasonable delay before applying the default network settings. See details in 11.1  Booting up the 
targets . 
 
If not configured in either way, the deployment server will be found automatically. 

 

  
 

Settings for the ManageEngine OS Deployer Agent 
 

The option to save the agent’s log to the deploy server is designed for troubleshooting. Normally, 
you should leave this checkbox unchecked because additional operations performed by the agent 
can slow down the deployment. If you choose to save the agent’s log, the log will be available on 
the deploy server in:  
\Documents and Settings\All Users\Application Data\ManageEngine\DeployServer\AgentsLogs. 

 
3. Select the type of bootable media to create. You can: 

 
- create CD, DVD, diskettes or other bootable media such as USB flash drive if the hardware BIOS 

allows for boot from such media 
- build an ISO image of a bootable disc to burn it later onto a blank disc 
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- upload the selected components to the PXE server. The previously uploaded components will be 
deleted from the PXE server before uploading the newly selected ones. 
 
When using 3.5” diskettes, you will be able to write only one component at a time on a diskette 
(or a set of the diskettes) — for example, ManageEngine OS Deployer Agent. To write another 
component, start the Bootable Media Builder once again. 

 
4. To create physical media, insert the blank disk, so the program can determine its capacity, or 

attach the flash drive. 
To create a bootable disk ISO image, specify the ISO file name and the folder in which to place it. 
To upload the components to a PXE server, specify the server and provide the user name and 
password to access it.  
 

5. The components being uploaded to the PXE server can be protected with a password to prevent 
the components from unauthorized execution. The password prompt will come up before 
displaying the ManageEngine boot menu.  

 

 
 

Protecting the boot menu with a password 
 
 
6. Next, the program will calculate how many blank disks are required (in case you have not chosen 

ISO or PXE) and give you time to prepare them. When you have finished, click Proceed. 
 
After you create a boot disk, mark it and keep it in a safe place. 
 

 

ManageEngine OS Deployer bootable components are based on Linux kernel and equipped 
with the Linux system and device drivers.  
ManageEngine regularly supplements the driver set with drivers for new devices. However, 
there may be a chance of drivers being incompatible with your hardware and the bootable 
component cannot start, hangs or cannot access the necessary device. In this case, try to 
elude using Linux drivers by building Bart PE or Win PE media with ManageEngine OS 
Deployer command line utility. 
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6.  Configuring PXE Server 
 
You can access ManageEngine PXE server configuration in the following ways: 
- when creating ManageEngine bootable media 
- when creating bootable media for custom deployment mode 
- using direct server configuration. 
 
To perform the direct PXE server configuration:  
1. Start ManageEngine OS Deployer Management Console 
2. Click Configure PXE Server 
3. Connect to the server. 
 
Configure PXE Server – click to upload ManageEngine OS Deployer bootable components in the 
same way as when creating ManageEngine bootable media. The previously uploaded components, 
including PE image, will be deleted from the PXE server before uploading the newly selected ones. 
 
Upload PE to PXE Server – click to upload the Preinstallation Environment image (.wim or .iso) 
previously created with ManageEngine OS Deployer PE builder. See details in 15.2  Uploading PE 
images to ManageEngine PXE Server. 
 
Remove products from PXE Server – click to remove any component or PE from the PXE server. 
 
Disable PXE Server – click to disable the PXE server. The service does not stop, but no longer 
responds to incoming requests. 
 
Enable PXE Server – click to enable the disabled PXE server. 
 

 
 

ManageEngine bootable components are uploaded 
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7.  Taking an image 
 
To be able to deploy a system, you need to create the desired system configuration and save the 
image of the system hard disk on a network share, detachable or removable media. 
 
ManageEngine OS Deployer also supports images taken with the Acronis True Image products family, 
including password protected images. 
 

7.1  Preparation of the master OS 
 
It is very common to prepare a master operating system with the Microsoft System Preparation Tool 
(Sysprep) before creating the system image. Sysprep is designed for corporate system administrators, 
OEMs, and others who need to deploy and automatically configure operating systems on multiple 
computers.  
 
After a syspreped operating system is deployed, Sysprep generates a unique security ID (SID) for the 
new host, initiates Windows mini-setup for plug-and-play devices, applies the computer name, domain 
or workgroup membership and other settings specified in the Sysprep.inf answer file.  
 
Use Sysprep on the master system if the system image will be deployed in Preinstallation Environment 
with ManageEngine OS Deployer command line utility. The command line utility cannot generate a SID 
or adjust settings on the fly, it simply deploys the system as is.  
 
In ManageEngine environment (any case except for command line mode), ManageEngine OS Deployer 
automatically configures the deployed system using parameters you set in the deployment template. 
Therefore, you have the choice of using the functionality of either Sysprep or ManageEngine OS 
Deployer. 
 
You can download Sysprep from www.microsoft.com or extract it from deploy.cab located on Windows 
NT/2000/XP/Server 2003 installation CD. 
 

 

We strongly recommend that you read articles about Sysprep and disk duplication in the 
Microsoft Knowledge Base. 

 

7.2  Online vs. offline imaging 
 
A master image can be taken: 
- online, in Windows, using ManageEngine OS Deployer Management Agent installed on the master 

computer and ManageEngine OS Deployer Management Console 
- offline, in ManageEngine environment, using bootable ManageEngine Master Image Creator 
- offline, in Win PE environment, using the ManageEngine OS Deployer command line utility or 

scripting. 
 
Running the agent in Windows is an obvious choice if you plan periodic remote imaging. Imaging with 
the agent does not require the master computer reboot. ManageEngine OS Deployer Management 
Agent will be included in the master image and deployed on all target computers. This will enable you 
to manage files and execute applications on target computers at any time after deployment.  
 
Normally you do not want excess software in a master image. Besides, installation of the agent will 
take a license. Therefore, we recommend that you do not install ManageEngine OS Deployer 
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Management Agent and create a master image using ManageEngine Master Image Creator or the 
command line utility in PE. 
 
The next sections describe imaging with ManageEngine OS Deployer Management Agent and 
ManageEngine Master Image Creator. For information about imaging in PE please see 15.  Command 
line and scripting under Win PE  
 

7.3  Starting offline imaging 
 
Offline imaging means that the master system is stopped and the master computer boots into 
ManageEngine (or PE) environment. 
 
1. Install ManageEngine OS Deployer Management Console.   

2. Do one of the following: 

Create bootable media with ManageEngine Master Image Creator 

or 

Install ManageEngine PXE Server, connect the console to the PXE server and upload ManageEngine 
Master Image Creator. Make sure that network booting is enabled on the master computer (see 3.7.2  
Setting up a computer to boot from PXE for details.)     

3. Configure the master system. 

4. Do one of the following: 

Boot the master computer into ManageEngine Master Image Creator from bootable media 

or 

Boot the master computer into ManageEngine Master Image Creator from the PXE Server. 

5. Select ManageEngine Master Image Creator in the boot menu. 

While creating bootable media or uploading ManageEngine Master Image Creator to the PXE 
server, the image creator can be configured to start automatically on timeout. 
 

6. The Master Image Creator establishes network connection to be able to save the image on a 
network share. A dialog box comes up suggesting that you configure the network connection used 
by the image creator.  

By default, ManageEngine Master Image Creator uses DHCP auto configuration. Ignore the prompt 
(click Cancel) if there is a DHCP server on the network or the image has to be placed on a local 
HDD or media. 
 
The image creator can be pre-configured to apply the default network settings automatically on 
timeout. 
 
The manual configuration is needed if auto configuration is not possible (no DHCP server on the 
network) or does not succeed. To configure the network connections manually, click OK in the 
prompt window. 

 
Set the preferable values and click OK. 

 
7. When ManageEngine Master Image Creator starts, it displays the Master Image Creator welcome 

window: 

 
8. In this window, click Next and go to step 7.5.1  Disks or partitions to image. 
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7.4  Starting online imaging 
 
Online imaging means that the master system is imaged live (without reboot or suspending 
operations). Online imaging can be performed remotely whenever you need. The disadvantage is that 
you have to install imaging software that is included in the master image. This is not always rational.  
 
1. Install ManageEngine OS Deployer Management Console and ManageEngine License Server. 

Import licenses to the license server. 

2. Configure the master system. 

3. Install ManageEngine OS Deployer Management Agent on the master system locally or remotely, 
using ManageEngine OS Deployer Management Console. Reboot on prompt. Once ManageEngine 
OS Deployer Management Agent is installed, you can image the master system online (without 
reboot) at any time. 

4. Start the ManageEngine OS Deployer Management Console. 

5. Connect to the master computer. 

6. Select Create Master Image -> Next -> Create master image on a remote computer. 

If you choose Create master image using bootable media, the program will suggest that you 
create the bootable media for offline imaging. 
 
 

7.5  Steps of the Master Image Creation Wizard 

7.5.1  Disks or partitions to image 
Select the disks or partitions to image. You can select a random set of disks and partitions. The Master 
Boot Record (MBR) will be also included in the image.  
 

 

If your operating system and its loader reside on different partitions, always include both 
partitions in the image. The partitions must also be deployed together; otherwise there is a 
high risk that the operating system will not start. 
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Select disks and partitions to image 
 
 

7.5.2  Image name and location 
 
ManageEngine Master Image Creator can save an image: 
- on a network share 
- on the master computer internal hard drive 
- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached to the 

master computer 
- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the master computer media drive.  
A sizeable image can be split between multiple media automatically.  
 
Select the image location in the device tree. Type the name of the file in the Filename field. The 
program can generate a unique file name. Just click the Generate name for a new file button on 
the right. 
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Selecting the image location 
 
 

7.5.3  Setting options 
 
Set the options for creating the master image. 
 
1. [OPTIONAL] Password for the image  
 
The preset is no password. 
Protect the image with a password to prevent unauthorized deployment. 
 
2. Compression level 
 
The preset is Normal.  
The data compression level for the image being created.  
 
The description field provides estimations for image size and image creation time for each compression 
level. You can select the compression level based on these estimations. The default Normal level is 
recommended in most cases. 
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Selecting the data compression level 
 
3. [FOR ONLINE IMAGING ONLY] Image creation priority 
 
The preset is Low. 
 
The priority of any process running in a system determines the amount of CPU usage and system 
resources allocated to that process. Decreasing the image creation priority will free more resources for 
other CPU tasks. Increasing of image creation priority could speed up the imaging by taking resources 
from the other running processes. The effect will depend on total CPU usage and other factors. 
 
4. Archive splitting 
 
Sizeable images can be split into several files that together make up the original image. 
  
The preset is Automatic. With this setting, the program will act as follows.  
 
When creating an image on a hard disk:  

If the selected disk has enough space and its file system allows the estimated file size, the 
program will create a single image file.  
 
If the storage disk has enough space, but its file system does not allow the estimated file size, 
the image will automatically be split into several files. Such might be the case when the image 
is placed on FAT16 and FAT32 file systems that have a 4 GB file size limit.  
 
If free space on the disk runs out while creating an image, the program will warn you and wait 
for your decision as to how you plan to fix the problem. You can try to free some additional 
space and continue or click Back and select another disk.  

 
When creating an image on a CD-R/RW, DVD-R/RW or DVD+R/RW diskette:  

ManageEngine Master Image Creator will ask you to insert a new disk when the previous one 
is full. 
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You also can select Fixed size and enter the desired file size or select it from the drop-down list. The 
image will then be split into multiple files of the specified size. This comes in handy when creating an 
image that you plan to burn to multiple CD-R/RW, DVD-R/RW or DVD+R/RW later on. 
 

 

Creating images directly on CD-R/RW, DVD-R/RW or DVD+R/RW usually takes more time 
than it would on a hard disk. 

 
5. [OPTIONAL] Additional settings 
 
Validate the image upon operation completion 
The preset is disabled. 
If enabled, the program will check the integrity of the just created image. 
 
Reboot the computer automatically after imaging is finished. 
The preset is disabled. 
 

7.5.4  Comments and summary 
 
[OPTIONAL] It is recommended that you provide a comment for easy identification of the image.  
 
Next you will see the imaging procedure summary. Check the settings and click Proceed. 
The imaging operation starts and its progress is displayed. 
 

 
 

ManageEngine OS Deployer is taking the master image 
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8.  Checking the master image  
 
To be assured that a master image is not damaged, you can check its integrity. 
 
1. Connect to a computer where ManageEngine OS Deployer Management Agent is installed. 

2. Select Check master image. 

3. Follow the wizard’s instructions to select the image. 

4. Click Proceed in the summary window. 

 
The checking operation starts. You can stop the operation if need be by clicking Cancel.  
 
After the check is complete, the program shows the result. 
 

54                                                            Copyright © Acronis, Inc., 2009. All rights reserved. 
Copyright © 2009 AdventNet, Inc. All rights reserved. 



 

 

9.  Deployment templates 
 
A deployment template is a set of configuration parameters of the deployment operation. This 
includes: 
 
1. A path to the master image 
2. The operation mode (multicast or unicast, how to handle the target disk free space etc.) 
3. Settings to be applied to the deployed systems (DNS names, user accounts etc.) 
4. Operations to be performed on the deployed systems (transfer files, execute applications, shut 

down, restart.) 
 

9.1  Why save templates? 
 
Deployment templates can be saved on the ManageEngine OS Deploy Server. Once you save a 
deployment template, you can use it in the future. When setting up a manual, scheduled or event-
driven deployment, simply select a template and set up the condition for starting deployment. 
Otherwise, you will have to configure the above parameters while setting up the deployment 
operation.  
 
Templates also enable the custom deployment mode. In this mode users can perform one-click 
deployment on their computers without the administrator’s assistance. To set up this mode, the 
administrator must create the standard deployment templates in advance. 
 
The saved templates are listed in the Templates tab. A template can be viewed, edited or deleted 
from the ManageEngine OS Deploy Server. 
 

9.2  Creating templates 
 
1. Connect the console to the ManageEngine OS Deploy Server. 
 
2. Select the Templates tab.  

 
3. Click Create Template on the sidebar. 
 
Further sections of this chapter tell you how to use the Create Deployment Template Wizard. 
 

9.2.1  Master image selection 
 
Specify: 
- The master image. 
- The user name and password for the network shared folder if the image is on the network. The 

best practice is to map the shared folder as a local drive (Windows Explorer -> Tools -> Map 
Network Drive.) 

 
ManageEngine OS Deploy Server can deploy images located:  
- in network shared folders 
- on the deploy server internal hard drive 
- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached to the 

deploy server  
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- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the deploy server media drive.  
 
The best practice is keeping images on the deploy server hard drive. This minimizes network traffic 
during deployment.  
 
The image created on removable media has to fit into one media disk. To deploy an image spread 
over several CDs, DVDs or other media, copy all parts of the image to the same folder on the deploy 
server or on a network share. 
 
ManageEngine Standalone Utility can deploy images located:  
- in network shared folders 
- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached to the 

managed computer  
- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the managed computer media drive.  
 

The image created on removable media has to fit into one media disk. To deploy an image spread 
over several CDs, DVDs or other media, copy all parts of the image to the same folder on an external 
drive or a network share. 
 

 
 

Selecting a master image 
 
 

9.2.2  Disk/partition selection 
 
Specify: 
- The disk to deploy, if the image contains multiple disks.  
- The disk partitions to deploy, if the image of the selected disk contains multiple partitions.  
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Selecting a disk from the master image 
 
 
The further steps will depend on how many partitions you select.  
 
 
If you deploy one partition, it is assumed that the target disk has partitions and you will have to select 
the target partition, to deploy over it. Other partitions will remain untouched. The active partition of 
the target disk will remain active - even if you deploy an active partition side by side with it, the newly 
deployed partition will not become active. Therefore, deploy an active partition to an active partition if 
you want to boot from the deployed partition. 
 
 
Deploying more than one partition will clear partitioning of the target disk. Only the newly deployed 
partitions will exist on the disk after deployment. 
 
 
The Master Boot Record (MBR) is always deployed from the image regardless of your choice. 
 
 

 

If your operating system and its loader reside on different partitions, always include both 
partitions in the image. The partitions must also be deployed together; otherwise there is a 
high risk that the operating system will not start. 
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Selecting disk partitions to deploy 
 

9.2.3  Target disk and partition selection 
 

Select the target disk for deployment. By default, the image will be deployed to the hard disk, which 
is specified in BIOS as number 1 (0Х80). 

 

 
 

Selecting the target disk 
 

Select the target partition to deploy, if one partition was selected for deployment. By default, the 
partition image will be deployed to partition 1 of the selected hard disk. To deploy a single partition to 
unallocated space or bare metal, first create the target partition using a third-party partitioning tool, 
such as Microsoft Disk Management or ManageEngine Disk Director. 
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When deploying a whole disk or multiple partitions, you will not see the target partition selection 
window. In this case, the target disk partitioning will not be preserved. 
 

 

 
 

Selecting the target partition 
 
 

9.2.4  User accounts 
 

[OPTIONAL] Specify local user accounts that you want to create on the target computers in addition to 
the accounts that exist in the master system.  
 
Users can be added to the Administrators, Power Users or Users groups. Here you have an 
opportunity to add a unified administrator’s account to all the systems, if needed. The Edit and 
Delete buttons are provided to change the accounts you typed in.  
 
The password complexity has to meet the password policy set for the master computer. To view or 
edit the password policy on the master computer: 

1. Run Microsoft Management Console (MMC) 
2. File -> Open -> %windir%\system32\secpol.msc 
3. Select Account Policies\Password Policy. 

 
 

9.2.5  Computer names and domain/workgroup 
 

[OPTIONAL] Specify DNS names and domain or workgroup membership of the target computers. If 
you have selected the domain membership, later you will be asked for the domain administrator’s 
name and password. 
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Naming the computers 
 
To generate unique names for target computers use wild cards as follows. 
 
{start} 
{1} 
This will generate names 1, 2, 3…N 
{start,count}  
{1,5} 
This will generate names 1, 2, 3, 4, 5 
 
Text{start} 
Name{1} 
This will generate names Name1, Name2, Name3…NameN 
 
Text{start,count} 
Name{1,5} 
This will generate names Name1, Name2, Name3, Name4, Name5 
 
{start1,count1}{start2,count2} 
start1  – the first figure in a two-figured number 
count1  – increasing quantity of first figures 
start2  – the second figure in a two-figured number 
count2  – increasing quantity of second figures 
 
{1,3}{1,4} 
This will generate names 11, 12, 13, 14, 21, 22, 23, 24, 31, 32, 33, 34 
{1,9}{0,10} 
This will generate names 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24…99  
 
Text{start1,count1}{start2,count2} 
Computer{2,3}{5,4} 
This will generate names Computer25, Computer26, Computer27, Computer28, Computer35, 
Computer36, Computer37, Computer38, Computer45, Computer46, Computer47, Computer48 
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9.2.6  Network settings 
 
Configure the Internet Protocol (IP) settings for the target computers. You have options to preserve 
the master system network settings, to obtain IP addresses automatically from DHCP server or to 
specify a range of static IP’s, subnet mask and default gateway in case you network does not have 
DHCP capability. 
 

 
 

Network settings: TCP/IP  
 

[OPTIONAL] If you have not selected to preserve the master system settings, specify DNS properties 
as well. Otherwise this step is skipped. 
 

  
 

Network settings: DNS server  
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9.2.7  Security identifiers 
 
ManageEngine OS Deployer can generate unique security identifiers (SIDs) for the target computers. 
This option is normally enabled. The SID can remain unchanged if there is no computer with the same 
SID in the same workgroup or domain. Also, it is recommended not to change the SID if the image is 
deployed on the same computer where the image was taken from. 

 

  
 

New SIDs will be generated for the target computers   
 

9.2.8  Transferring files 
 

[OPTIONAL] Select files to be transferred to all target computers after deployment (for example, 
installation files.) The files must be located on a network share. Check Execute file if you want to 
execute the files after deployment.  
 

9.2.9  Executing applications 
 
[OPTIONAL] You can specify service applications (from the master system image) for executing on the 
target computers after deployment.  

 
 

9.2.10  Using ManageEngine Universal Deploy 
 

[OPTIONAL] 
ManageEngine Universal Deploy is an add-on to ManageEngine OS Deployer. It is purchased 
separately and installed from a separate setup file.  
 
Skip this section if one of the following is true:  

- you do not have ManageEngine Universal Deploy 
- you want to deploy an image that does not contain Windows. 
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1. Select whether to use ManageEngine Universal Deploy. 
ManageEngine Universal Deploy will help you create a bootable Windows clone on different hardware 
by automatically installing the necessary system drivers. Use ManageEngine Universal Deploy when 
deploying Windows to a computer with a dissimilar processor, different motherboard or other mass 
storage device than in the imaged system. For detailed information see 2.5  What is ManageEngine 
Universal Deploy. 
 

 
 

Select whether to use ManageEngine Universal Deploy 
 
ManageEngine Universal Deploy uses three sources for drivers:  

- the Windows default driver storage folder (in the image being deployed)  
- the mass storage device driver specified by the user 
- the driver repository - a folder or folders on a network share or removable media. 

 
The program will find the most suitable drivers of all available drivers and install them into the 
deployed system. However, the driver defined by the user, will have the priority. It will be installed, 
with appropriate warnings, even if the program finds a better driver. 
 
 
2. [OPTIONAL] Specify the mass-storage driver 
If the target hardware has a specific mass storage controller (such as a SCSI, RAID, or Fibre Channel 
adapter) for the hard disk, explicitly specify the appropriate driver for this controller. The driver will be 
installed in any case, bypassing the automatic driver search-and-install procedure. 
 
Use this option only if the automatic search-and-install procedure was unsuccessful. 
 

 

When deploying the system to a virtual machine that uses SCSI hard drive controller, be sure 
to specify SCSI drivers for virtual environment. For example, VMware requires Buslogic or LSI 
logic drivers. Use drivers bundled with your virtualization software or download the latest 
driver versions from the software manufacturer website. 

 
3. [OPTIONAL] Specify the driver repository 
Specify a driver storage to search for HAL and storage device drivers during the automatic search-and-
install procedure. You can add network locations and enable a search of removable media for drivers. 
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Adding a driver repository 
 
 

9.2.11  Deployment options 
 
 
Select the options for the deployment operation. You may select Use default options or Set the 
options manually. If the latter is the case, the settings will be applied only to the current 
deployment template.  
 
 
Alternatively, you can edit the default options. To do so, select Use default options and click Tools 
-> Options in the description field. Edit the options and click OK. Your settings will be saved as the 
defaults. When not creating a template, you can access default options through Tools -> Options in 
the program menu or on the toolbar. 
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The full list of deployment options 
 
 
Action after deployment 
The preset is Shutdown. 
Choose whether to turn off or restart the target computer after the deployment and all associated 
operations, scheduled in this wizard (transferring files, executing applications) are completed. 
 
 
Disk utilization 
The preset is Occupy disk space entirely. 
If the target disk capacity is not equal to that of the master computer’s disk, the program can enlarge 
(or reduce) each partition according to the proportion of the master and target disk capacities. 
Alternatively, if the target disk is larger, the program can keep the original partitions’ size and leave 
the remaining disk space unallocated. 
 
 
Licensing 
The preset is Stop operation. 
ManageEngine OS Deployer uses two types of licenses. A license for the server product is needed to 
deploy a server operating system. A license for the workstation product is needed to deploy a 
workstation operating system. By default, a workstation OS will not be deployed if the ManageEngine 
License Server has licenses only for the server product. 
 
You have an option to use the server product license instead of the workstation license automatically 
or through a prompt.   
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Licensing 
 
Network utilization 
The preset is Multicast. 
You can choose the data transfer mode for the deployment. With the Multicast transfer mode, 
ManageEngine OS Deploy Server sends data to a group of recipients simultaneously. Using the Unicast 
transfer mode, the server sends a copy of the data to each recipient (this can significantly reduce the 
deployment speed.)  
 
For example, you have 128 KB/sec bandwidth and want to deploy a system on 10 target computers.  
- With Unicast mode, the server divides 128 KB/sec among 10 computers, therefore the data 

transfer speed will be 12.8 KB/sec for each target machine. 
- With Multicast mode, the server sends one copy of data to a multicast address, and each client 

will receive data at 128 KB/sec speed. 
 
Multicast configuration has a parameter that specifies the time to live (TTL) for multicast packets. Use 
this parameter to limit multicast packets distribution via gateways.  
 
The default value is 15. In practice, this enables the packets to pass up to 15 hops which may be 
treated as unlimited distance. The minimal value 1 will limit the packets circulation to one subnet. 
 
By setting the permitted bandwidth you can limit the network usage during deployment. 
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Adjusting network utilization 
 

ManageEngine OS Deployer uses Internet Group Management Protocol (IGMP) for the multicasting. 
Therefore, all the network hardware (routers and/or switches) must be IGMP-capable and correctly 
configured. The specific information on configuring any particular router or switch is usually available 
in the documentation, provided with the hardware. 
 
If there is no IGMP-capable hardware (or you cannot configure it correctly) in the network, use the 
Unicast data transfer mode. 
 
 
MAC filtering 
ManageEngine OS Deployer has the ability to disable deployment on computers with specified MAC 
addresses. This protects production servers and user’s systems from unfortunate events. The program 
can import the access list from a text file or save the MAC addresses you type in.  
 
Both straight (enabling) and inverse (disabling) lists are supported, but only one list can be active at 
any one time. 
 
The enabling (inclusion) list has to contain all computers that are allowed to be the deployment 
targets. You can add only one MAC address if a computer has more than one network interface card. 
Deployment through any network interface that is not in the list will be prohibited.  
 
The disabling (exclusion) list has to include all computers that are not allowed to be the deployment 
targets. Add all MAC addresses if a computer has more than one network interface card. Deployment 
through any network interface that is not in the list will be permitted.  
 

 

MAC filtering is a general option of ManageEngine OS Deploy Server and not a property of a 
deployment template. Whenever and whatever type deployment is executed, the program 
uses the access list that exists at that time. That’s why the option can be found when editing 
the default options only. 
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MAC filtering 
 

9.2.12  Comments and summary 
 
[OPTIONAL] It is recommended that you provide a comment for easy identification of the template.  
 

 
 

Type in a comment 
 
Check your settings in the summary window and click Save. 
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The summary window 
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10.  Standalone deployment  
 
Standalone deployment is deployment on a computer isolated from a network or included in a network 
without ManageEngine OS Deployer infrastructure, to be exact, without ManageEngine OS Deploy 
Server. Standalone deployment is performed locally using the bootable ManageEngine Standalone 
Utility.  
 
The ManageEngine Universal Deploy option is not available in the standalone mode. 

 
Steps: 
1. Install ManageEngine OS Deployer Management Console. 

2. Create bootable media with ManageEngine Master Image Creator and ManageEngine Standalone 
Utility. 

 

ManageEngine Standalone Utility can be placed on a physical media only. This component is 
not designed to boot from a PXE server. 

 
 

The ManageEngine standalone components to be placed on the bootable media 
 
3. Configure and image the master system. Save the image on a network share, detachable or 

removable media, because internal hard disks of the target computer cannot be accessed during 
the standalone deployment. 

4. Boot the target computer into ManageEngine Standalone Utility. 

5. Attach or insert the media if the master image or files to transfer are located on the media. 

ManageEngine Standalone Utility can deploy images located:  
- in network shared folders 
- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached to the 

managed computer  
- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the managed computer media drive.  

The image created on removable media has to fit into one media disk. To deploy an image 
spread over several CDs, DVDs or other media, copy all parts of the image to the same folder 
on an external drive or a network share. 
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6. Configure the deployment operation as described in 9.2.1 – 9.2.12. Note that the template cannot 

be saved because the standalone utility does not access the ManageEngine OS Deploy Server. 

7. Run the manual deployment. 
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11.  Manual deployment 
 
Manual deployment presumes that you first boot up the target computers and then apply the 
deployment template. The deployment will start immediately on clicking Proceed in the deployment 
wizard. 
 

11.1  Booting up the targets 
To perform manual or event-driven deployment you need to boot the target computers into 
ManageEngine OS Deployer Agent using either bootable media or ManageEngine PXE Server. 
 
Deployment presumes that you have created a master image, so at least the ManageEngine OS 
Deployer Management Console is installed.   
 
1. Install ManageEngine License Server. Import licenses to the license server. Install ManageEngine 

OS Deploy Server. 

2. Do one of the following: 

Create bootable media with ManageEngine OS Deployer Agent 
or 
Install ManageEngine PXE Server, connect the console to the PXE server and upload 
ManageEngine OS Deployer Agent  

3. Do one of the following: 

Boot the target computer(s) into ManageEngine OS Deployer Agent from bootable media 
or 
Boot the target computer(s) into ManageEngine OS Deployer Agent from the PXE Server. 

 
4. Select ManageEngine OS Deployer Agent in the boot menu. 

While creating bootable media or uploading ManageEngine OS Deployer Agent on the PXE server, 
the agent can be configured to start automatically on timeout. 
 

5. The agent has to establish network connection to be able to connect to ManageEngine OS Deploy 
Server. A dialog box comes up suggesting that you configure the network connection used by 
ManageEngine OS Deployer.  

By default, the agent will use DHCP auto configuration and connect to the first deploy server that 
is found on the network. You can ignore the prompt (click Cancel) if there is a DHCP server and 
only one ManageEngine OS Deploy Server on the network. The agent can be pre-configured to 
apply the default settings automatically on timeout. 
 
To configure the network connections manually, click OK in the prompt window. You can set up: 

 
- TCP/IP settings for each network interface of the target computer. 

ManageEngine OS Deployer Agent uses DHCP auto configuration by default. The manual 
configuration is needed if auto configuration is not possible (no DHCP server on the network) or 
does not succeed.  

 
- The ManageEngine OS Deploy Server the agent will connect to.  

This setting allows you to have multiple deployment servers that perform different functions on 
the same network. The deployment server can be specified also when creating bootable media 
with ManageEngine OS Deployer Agent. If not specified in either way, the server will be found 
automatically. 
Set the preferable values and click OK. 
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6. When the ManageEngine OS Deployer Agent starts and the target computer is ready for 
deployment, the target computer displays: 

The progress bar is frozen because the computer is waiting for deployment. 
 
 

11.2  Starting deployment 
1. Connect the console to the ManageEngine OS Deploy Server. 
 
2. Select the Deployment tab. The tab shows the computers booted into ManageEngine OS 

Deployer Agent and ready for deployment. 
 

 
ManageEngine OS Deploy Server: the agent is ready for deployment 

 
3. Click Manual Deployment on the sidebar. 
 
4. Select the computers to deploy to from the list of the connected computers. 
 
5. Select the previously created deployment template or configure the deployment operation as 

described in 9.2.1 – 9.2.12. 
 
6. Review the deployment operation summary and click Proceed to start the deployment. 
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12.  Event-driven deployment 
 
Deployment can be configured to start when the predefined number of computers is ready. The 
ManageEngine OS Deploy Server counts how many computers have connected to the server and starts 
multicasting when the desired number of computers is reached.  
 
The administrator can specify a time-out period. On time-out, deployment will start on the computers 
that are ready despite that the predefined number is not reached. 
 
This decouples configuring the deployment operation from booting up the target computers. With 
manual deployment, you boot up the targets first, configure deployment for these targets and start 
the operation manually. With event-driven deployment, you configure the deployment first, no matter 
if the targets are ready or not, and then boot up the targets. The operation will start as soon as the 
targets are ready or (optionally) on time-out. 
 
The administrator is able to skip these events and initiate deployment manually. 
 
Scenario: 

An organization receives 100 computers from a manufacturer. The IT department has to deploy 
systems, preconfigured according to the employees’ roles, to a predefined number of computers. 
For example, 10 computers for accountants, 10 computers for the marketing department, 70 
computers for sales and 10 for the managers. 

 
Steps: 
 
1. Install ManageEngine OS Deployer Management Console and ManageEngine License Server. 

Import licenses to the license server. Install ManageEngine OS Deploy Server. 

2. Create bootable media with ManageEngine Master Image Creator. 

3. Configure and image the master system. 

4. Create and save a deployment template. The template includes a path to the master image. Let’s 
say the master image is configured for sales people. 

5. Do one of the following: 

Create bootable media with ManageEngine OS Deployer Agent 
or 
Install ManageEngine PXE Server, connect the console to the PXE server and upload 
ManageEngine OS Deployer Agent. 
  

6. Connect to the ManageEngine OS Deploy Server and click Event-Driven Deployment on the 
sidebar. 

7. Select the condition that triggers the deployment. 

Enter the number of computers you need to deploy, say, 70 computers for sales.  
 
If the time-out is not specified (the check box is not checked), the deploy server will wait until any 
70 computers boot into ManageEngine OS Deployer Agent and connect to the server. 
 
If you specify the time-out (check the box and set the time), the deployment will start either when 
any 70 computers connect, or when the time runs out and at least one computer is connected. 
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Triggering conditions for event-driven deployment 
 

8. Select the previously created deployment template or configure the deployment operation as 
described in 9.2.1 – 9.2.12. 

 
9. Review the deployment operation summary and click Proceed to commit the event-driven 

deployment. The Deployment tab will appear like the graphic below. 
 

 
 

ManageEngine OS Deploy Server is waiting for targets to connect to start event-driven 
deployment 
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10. Do one of the following: 

Boot the target computer(s) into ManageEngine OS Deployer Agent from bootable media 
or 
Boot the target computer(s) into ManageEngine OS Deployer Agent from the PXE Server. 
See details in 11.1  Booting up the targets. 
 

11. As target computers connect to the deploy server, they appear in the upper list “Computers 
available for deployment”. While the deploy server is waiting, you are able to: 
-   Cancel event-driven deployment  
-   Start the manual deployment on the available computers (click Manual deployment on the 
sidebar) 
 
As soon as the triggering condition arises, the available computers become engaged in the event-
driven deployment and move to the lower list “Deployment (Start by event)”. 
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13.  Scheduled deployment 
 
 
Deployment can be run on a schedule. Scheduling presumes that when the scheduled time comes, the 
program will power on the computers with predefined MAC addresses using the BIOS Wake On LAN 
(WOL) functionality.  
 
Computers in other subnets can be woken through a WOL proxy agent delivered with ManageEngine 
OS Deployer. 
 
Computers that do not support WOL can be booted into ManageEngine environment manually before 
the scheduled time comes. Such computers will also be deployed provided that their MAC addresses 
are included in the total list. 
 
Scenarios: 
 

1. An organization receives a shipment of computers from a manufacturer along with the list of 
their MAC addresses. The IT department has to deploy the operating system to the new 
hardware. 

2. An Internet café, a school or university lab has 100 computers with known MAC addresses. 
The nightly deployment of the initial standard image on these computers is needed.  

 
 

13.1  Preparation steps 

13.1.1  Getting MAC addresses 
 
Media Access Control address (MAC address) is a 48-bit physical (hardware) address of a network 
device. In Windows, the physical address can be obtained with ipconfig /all or by selecting Local 
Area Connection -> Status -> Support -> Details.  
 
MAC addresses for bare metal are usually supplied by the hardware manufacturer. You can get a MAC 
address of any PC-compatible hardware by entering the network configuration menu of any 
ManageEngine bootable component (ManageEngine Master Image Creator, for example): 
 
An administrator can execute a script that collects MAC addresses of networked computers and saves 
them in a text file. The text file can then be imported by ManageEngine OS Deployer. This can be a 
plain text file: 

; comment 
00-01-23-45-67-1A              ; comment 
02-01-23-45-67-1B 

 
An option to type in the hex MAC addresses is also provided.  
 

13.1.2  Enabling WOL on targets 
 
Before using scheduled deployment, make sure that Wake on LAN is enabled on the target computers. 
Enter the computer BIOS and set Power -> Wake On PCI PME -> Power On (the exact names 
might vary depending on the BIOS version.) 
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To enable the Wake on LAN feature on a Windows computer set the NIC properties on the computer 
as follows: 
Control Panel -> System -> Device Manager -> Network adapters -> select the NIC -> 
Properties -> Advanced: 
Enable PME -> Enabled 
Wake On Link Settings -> OS Controlled 
Wake On Settings -> Wake On Magic Packet. 
 

13.2  Scheduled deployment within one subnet 
 
When the scheduled time comes, ManageEngine OS Deploy Server sends out magic packets according 
to the predefined list of MAC addresses. (A magic packet is a packet that contains 16 contiguous 
copies of the receiving NIC's Ethernet address.) The targets wake, boot into ManageEngine OS 
Deployer Agent from the ManageEngine PXE Server and connect to the deploy server. When all (or 
some, depending on your choice) targets connect, the deploy server starts multicasting. 
 

 
 

 
Scheduled deployment within one subnet 

 
Steps: 
1. Install ManageEngine OS Deployer Management Console and ManageEngine License Server. 

Import licenses to the license server. Install ManageEngine OS Deploy Server and ManageEngine 
PXE Server. 

2. If ManageEngine PXE Server and the DHCP server are on the same computer, add to the DHCP 
server option 60: “Client Identifier” with string value “PXE Client”.  This can be done as follows: 

C:\WINDOWS\system32>netsh 
netsh>dhcp 
netsh>dhcp>server \\<server_machine_name> or <IP address> 
netsh dhcp>add optiondef 60 PXEClient STRING 0 comment=”Option added for 
PXE support” 
netsh dhcp>set optionvalue 60 STRING PXEClient 
 
3. Make sure that Wake on LAN is enabled on the target computers. If you cannot or do not wish to 

use Wake on LAN on some or all of the target computers, you will have to boot them into 
ManageEngine OS Deployer Agent manually before the scheduled time comes. 

4. Create bootable media with ManageEngine Master Image Creator. 

5. Configure and image the master system. 

6. Create and save a deployment template. 

7. Create a list of target MAC addresses. This can be a plain text file: 

; comment 
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00-01-23-45-67-1A              ; comment 
02-01-23-45-67-1B 
 

8. Configure ManageEngine PXE Server:  

- upload ManageEngine OS Deployer Agent (to boot the targets into the agent before 
deployment) 

- set Booting from HDD as the default boot menu item (to boot the targets into the deployed 
OS after the deployment)  

- set up a reasonable timeout so that the OS can start automatically. 

9. Connect to the ManageEngine OS Deploy Server and click Scheduled Deployment on the 
sidebar. 

10. Import or type in the list of target MAC addresses. 

11. Select Wake-on-LAN. 

12. The next window suggests that you tune the PXE server to use with the deployment server you 
are connected to. The goal of this setting is to boot the woken machine into ManageEngine OS 
Deployer Agent even if another component on the PXE server is configured to start automatically.  

The tuned PXE Server will redirect the boot menu configuration requests that come from the 
booting machines, to the current OS Deploy Server. The deploy server responds with the file 
specifying the boot menu item for the given MAC address. If the MAC address of the booting 
machine is included in the list of target MAC addresses, the machine will boot into ManageEngine 
OS Deployer Agent, despite that Booting from HDD is configured as the default boot menu item. 

Tuning a PXE server implies that you can guarantee that the woken machines will be served by 
this PXE server. Normally, you have only one PXE server in the given subnet.  

Once tuned to the certain OSDS, the PXE server remains tuned at this setting unless it is tuned to 
another OSDS by another scheduled task. If this setting has never been configured, the woken 
machine will boot into the component that is configured to start automatically. 

Type in “localhost” if the PXE server and the deployment server are on the same machine. 

 

  
 

Tune PXE server  
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13. Select whether to start deployment one-by-one, as computers connect to the deploy server, or to 

wait for all the computers to connect.  

In practical situations, some of the listed computers might not connect because they are in use, 
for example. One-by-one deployment task will continue waiting for missing computers, while the 
rest of the computers are already deployed. Because it may not be practical or efficient for you to 
have the task suspended (especially a periodic task), the program allows you to specify the 
maximum waiting time and the minimum number of computers on which the deployment will start 
when the time is out. 

 

 
 

Triggering conditions for scheduled deployment  
 
14. Select the deployment template. 

15. Set up the deployment schedule: 

- One time only – the task will be executed once at the specified time and day 

- Daily (or several times a day) - the task will be executed once a day or once in several days 

- Weekly - the task will be executed once a week or once in several weeks on the selected day 

- Monthly - the task will be executed once a month on the selected day 

Do not forget that the target computers must be powered off or booted into the ManageEngine OS 
Deployer Agent before the scheduled time comes. 
 

16. Review the scheduled task summary and click Proceed to save the task. 

17. Select the Scheduled Deployment Tasks tab and make sure that the task is saved. 

18. When the task is started, the connected computers’ IPs and the task progress will be displayed on 
the Deployment tab. 

19. When the task is finished, its log will be available in the ManageEngine OS Deploy Server log.  
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13.3  Scheduled deployment in other subnet 
 
Computers in other subnets can be woken through a WOL proxy. The WOL Proxy agent is delivered 
with ManageEngine OS Deployer.  
 
When the scheduled time comes, ManageEngine OS Deploy Server sends out magic packets according 
to the predefined list of MAC addresses. (A magic packet is a packet that contains 16 contiguous 
copies of the receiving NIC's Ethernet address.) ManageEngine WOL Proxy transfers the packets to 
targets located in other subnet. The targets wake, boot into ManageEngine OS Deployer Agent from 
the ManageEngine PXE Server and connect to the deploy server. When all (or some, depending on 
your choice) targets connect, the deploy server starts multicasting. 

 

 
 

 
Scheduled deployment in other subnet using ManageEngine WOL Proxy 

 
Steps: 
1. Install ManageEngine OS Deployer Management Console and ManageEngine License Server. 

Import licenses to the license server. Install ManageEngine OS Deploy Server and ManageEngine 
PXE Server.  

2. To enable the ManageEngine PXE Server to work in other subnet (across the switch), configure 
the switch to relay the PXE traffic. The PXE server IP addresses are configured on a per-interface 
basis using IP helper functionality in the same way as DHCP server addresses. For more 
information please refer to: 
http://support.microsoft.com/default.aspx/kb/257579 

 
3. If ManageEngine PXE Server and the DHCP server are on the same computer, add to the DHCP 

server option 60: “Client Identifier” with string value “PXE Client”.  This can be done as follows: 

C:\WINDOWS\system32>netsh 
netsh>dhcp 
netsh>dhcp>server \\<server_machine_name> or <IP address> 
netsh dhcp>add optiondef 60 PXEClient STRING 0 comment=”Option added for 
PXE support” 
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netsh dhcp>set optionvalue 60 STRING PXEClient 
 
4. Install ManageEngine WOL Proxy in the subnet where the target computers are. 

5. Make sure that Wake on LAN is enabled on the target computers. If you cannot or do not wish to 
use Wake on LAN on some or all of the target computers, you will have to boot them into 
ManageEngine OS Deployer Agent manually before the scheduled time comes. 

6. Create bootable media with ManageEngine Master Image Creator. 

7. Configure and image the master system. 

8. Create and save a deployment template. 

9. Configure ManageEngine PXE Server:  

- upload ManageEngine OS Deployer Agent (to boot the targets into the agent before 
deployment) 

- set Booting from HDD as the default boot menu item (to boot the targets into the deployed 
OS after the deployment)  

- set up a reasonable timeout so that the OS can start automatically. 

10. Create a list of target MAC addresses. This can be a plain text file: 

; comment 
00-01-23-45-67-1A              ; comment 
02-01-23-45-67-1B 
 

11. Connect to the ManageEngine OS Deploy Server and click Scheduled Deployment on the 
sidebar 

12. Import or type in the list of MAC addresses 

13. Select Wake-on-LAN Proxy and type in the ManageEngine WOL Proxy’s IP address and the 
access credentials. Test the credentials. 

 
 

Specifying ManageEngine WOL Proxy 
 
14. The next window suggests that you tune the PXE server to use with the deployment server you 

are connected to. The goal of this setting is to boot the woken machine into ManageEngine OS 
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Deployer Agent even if another component on the PXE server is configured to start automatically. 
See details in the previous section. 

15. Select whether to start deployment one-by-one, as computers connect to the deploy server, or to 
wait for all computers to connect. 

16. Select the deployment template. 

17. Select and set up the deployment schedule: 

- One time only 

- Daily (or several times a day) 

- Weekly 

- Monthly 

Do not forget that the target computers must be powered off or booted into the ManageEngine OS 
Deployer Agent before the scheduled time comes. 
 

18. Review the scheduled task summary and click Proceed to save the task. 

19. Select the Scheduled Deployment Tasks tab and make sure that the task is saved. 

20. When the task is started, the connected computers’ IP addresses and the task progress will be 
displayed on the Deployment tab. 

21. When the task is finished, its log will be available in the ManageEngine OS Deploy Server log.  

 

13.4  Operations with scheduled tasks 
 
Once a deployment task is scheduled, it appears on the Scheduled Deployment Tasks tab.  
 
A task scheduled for periodical execution stays on the deploy server until you delete it. A task 
scheduled for one-time execution will disappear as soon as the execution is completed. 
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ManageEngine OS Deploy Server: the deployment task is scheduled 
 
To delete a task, select it and click Delete. 
 
To edit a task, select it and click Edit. Editing is performed in the same way as creation, however, the 
earlier selected options will be set, and so you have to enter only the changes.  
 
Deleting or editing a task does not affect the current task execution. A task, that has been edited or 
deleted while running, will come to an end without any changes. The changes you made will be 
applied when execution is completed. 
 
To run a task immediately, select the task and click Start Task. The task schedule remains valid. 
 
To re-schedule a task or clear the task schedule, click Change Task Schedule. By clearing the task 
schedule you disable the task execution while not deleting the task. The task can be executed in the 
future when you add a new schedule using the same wizard. 
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14.  Custom deployment mode 
 
ManageEngine OS Deployer can be configured in such a way that users will be able to deploy and re-
deploy their computers with one click on the boot menu.  
 

14. 1  Understanding custom deployment 
 
An administrator creates a set of deployment templates that meet the organization’s needs and 
assigns to each template a name that can be easily understood by a user.  
 
The administrator creates bootable media or a PXE package containing the set of templates and 
switches on the custom deployment mode. 
 
Users that need to re-deploy their computers boot the computers from bootable media or PXE and 
select the template by name from the boot menu. The deployment starts immediately and proceeds 
independently on each computer. 
 
 

 
 

 
Custom deployment mode: a user initiates deployment 

 
 
In software testing labs the choices can be various operating systems, various editions of the same 
operating system, the same operating system with various settings or various applications. In a 
university or school lab the choices can be various exercises that students have to explore or the initial 
system image for the purpose of self-restore. 
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The custom deployment mode is intended for continual work without administrator’s assistance. Once 
the mode is set, other methods of deployment (manual, scheduled, event-driven deployment) become 
unavailable. Any scheduled task, that has to start while the custom deployment mode is on, will not 
start. Only users (the ones on the target side) can initiate deployment. However, the administrator can 
view logs, create new deployment templates, change the custom deployment configuration (add, edit 
or remove boot menu items) and perform other management operations except for deployment. 
 
To initiate deployment on the console side, the administrator switches off the custom deployment 
mode. 
 
 

14. 2  Considerations and tips 
 
When enabling or configuring the custom deployment mode with PXE, the program first removes all 
bootable utilities (ManageEngine OS Deployer Agent, ManageEngine Master Image Creator, PE image) 
from the PXE server since users might be confused by the unknown items appearing in the boot menu. 
Then the program uploads to the PXE the templates selected by the administrator. So you will have to 
upload the bootable utilities again, if they are needed after switching off the custom deployment 
mode. 
 
You can use another ManageEngine OS Deploy Server to perform manual, scheduled or event-driven 
deployment while one OS Deploy Server is in the custom deployment mode. To do so, ensure that the 
targets connect to the appropriate deployment server by specifying the OSDS on the bootable media 
or by configuring the ManageEngine OS Deployer Agent at boot up. The deploy servers cannot share 
the ManageEngine PXE Server though. 
 
 
 
 

14. 3  Setting up the custom deployment mode 
 
Steps: 
 
1. Install ManageEngine OS Deployer Management Console and ManageEngine License Server. 

Import licenses to the license server. Install ManageEngine OS Deploy Server and ManageEngine 
PXE Server.  

2. Create bootable media with ManageEngine Master Image Creator. 

3. Configure and image the master system(s). 

4. Create and save the deployment templates according to your organization’s needs. Assign to each 
template a name that can be easily understood by the users. 

5. Connect to the ManageEngine OS Deploy Server. If some deployment operations are active, either 
cancel the operations or wait until the operations are completed. 

6. Click Switch to Custom Deployment Mode on the sidebar. 

7. Select the templates to be added to the boot menu. 
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Adding templates to the custom boot menu 
 
8. Select Create boot media 

9. Select whether you want to create removable media, the media ISO or upload the templates to 
ManageEngine PXE Server. Having saved the media ISO, you can create as many media copies as 
the users need using third-party CD/DVD burning software. 

10. The templates being uploaded to the PXE server can be protected with a password to prevent the 
templates from unauthorized execution. The password prompt will come up before displaying the 
ManageEngine boot menu. 

11. Review the operation summary and click Proceed 

12. The program creates the media with the custom boot menu. ManageEngine OS Deploy Server 
switches to the custom deployment mode. 
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ManageEngine OS Deploy Server is in custom deployment mode 

 
12. The Custom Deployment tab shows the status of deployment operations performed on users’ 

requests. The tab is empty if none of the users are deploying at the moment. 
 
While the deploy server is in custom deployment mode, you are able to: 
- change parameters of the custom deployment mode 
- create new media for the custom deployment mode 
- stop the selected operation, if need be, by selecting Cancel Deployment 
- switch off the custom deployment mode. 

 
The user that requested deployment sees the following screen while the deployment is progress. 
 

 
 

Custom deployment in progress: view on the target side 

14. 4  Changing parameters of the custom deployment mode 
 
To change the templates or the boot menu password, used in the custom deployment mode, you will 
have to re-configure the custom deployment mode.  
 
1. If some user-initiated deployment operations are active, either stop the operations or wait until 

the operations are completed. 
 
2. Click Custom Deploy Parameters on the sidebar and repeat steps 6-10 in section 14.3.  
 

14. 5  Closing the custom deployment mode 
 
1. If some user-initiated deployment operations are active, either stop the operations or wait until 

the operations are completed. 
 
2. Click Switch off the custom deployment mode on the sidebar. 

 
3. In case the custom deployment mode used ManageEngine PXE Server, the program has to remove 

custom boot media from the server. Type in the credentials for the PXE server, if prompted.  
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15.  Command line and scripting under Win PE and Bart PE 
 
 
Windows Preinstallation Environment (Win PE) is a minimal Windows system based on the Windows 
XP Professional, the Windows Server 2003 or the Windows Vista kernels. Win PE is commonly used by 
OEMs and corporations for deployment, test, diagnostic and system repair purposes.  
 
ManageEngine OS Deployer provides a command line utility that can be added to a Windows 
Preinstallation Environment (Win PE) image. The ManageEngine Universal Deploy add-on, if installed, 
will also be included in the PE. The administrator can then upload the PE to a PXE server or transfer 
the PE image onto removable media. 
 
Having booted a machine in Preinstallation Environment, the administrator can perform imaging or 
deployment in the command line mode or execute scripts. Section 15.4  Sample scenarios provides 
examples of what you can do in PE. 
 
Limitation: 

 
ManageEngine OS Deployer command line utility can generate a new SID but cannot adjust 
other settings on the fly. To change the computer name, domain or workgroup membership 
and other settings, apply the Microsoft System Preparation Tool (Sysprep) to the master 
system and specify the new settings in the Sysprep.inf answer file. 

 

15.1  Adding ASD command line utility to PE 

15.1.1  ManageEngine OS Deployer PE Builder 
 
ManageEngine OS Deployer PE Builder is a dedicated component for adding ManageEngine OS 
Deployer command line utility to PE image. 
 
ManageEngine OS Deployer PE Builder is installed with the ManageEngine OS Deployer Management 
Console Typical or Complete installation. You can install the PE Builder alone using the Custom way 
of installation. 
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The PE builder comes with ManageEngine OS Deployer Management Console 
 
The PE Builder can add the ManageEngine OS Deployer command line utility to a Bart PE, Win PE 1.0 
or Win PE 2.0 image. To be able to add the command line utility to a Win PE 2.0 image (a .WIM file or 
a folder with PE 2.0 unpacked files) you must have Windows Automated Installation Kit (AIK) installed.  
 
For this purpose, install ManageEngine OS Deployer PE Builder on a computer where AIK is installed. If 
you do not have such machine, do as follows: 
 

- Download Windows Automated Installation Kit (AIK) from 
http://www.microsoft.com/Downloads/details.aspx?familyid=C7D4BC6D-15F3-4284-9123-
679830D629F2&displaylang=en 

- Burn the AIK to DVD or copy to a flash drive 
- Install the Microsoft .NET Framework v.2.0 from this kit (NETFXx86 or NETFXx64, depending 

on your hardware)  
- Install Microsoft Core XML (MSXML) 5.0 or 6.0 Parser from this kit  
- Install Windows AIK from this kit 
- Install ManageEngine OS Deployer PE builder. 

 

15.1.2  Adding ASD command line utility to PE 1.0 
 
1. Do one of the following: 

Unpack all files of your Win PE 1.0 ISO to a separate folder on the hard disk 

or  

Install Bart PE builder 
Use Bart PE builder and your Windows distribution to create a folder with Bart PE files 

To be able to boot from a PXE server, PE 1.0 must contain PXE loader. Check whether your 
Windows distribution has this loader. It appears as a packed file named STARTROM.N1_.  

 
2. Select ManageEngine -> ManageEngine OS Deployer -> ManageEngine OS Deployer PE 
Builder from the start menu. 

3. Do one of the following, depending on your choice in step 1: 

Specify path to the folder with PE 1.0 unpacked files 

or  

Specify path to the destination folder of Bart PE builder 

4. Specify the full path to the resulting file including the file name. 

5. Check your settings in the summary screen and click Proceed. 

6. Burn the .ISO to CD or DVD using a third-party tool or copy to a flash drive. For how to upload the 
.ISO to ManageEngine PXE Server, see 15.2  Uploading PE images to ManageEngine PXE Server. 

 

15.1.3  Adding ManageEngine OS Deployer command line utility to PE 2.0 
 
1. Select ManageEngine -> ManageEngine OS Deployer -> ManageEngine OS Deployer PE 
Builder from the start menu. 

2. Do one of the following: 

Specify path to the source WINPE.WIM file. The standard path to this file for x86 hardware is  
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\Program Files\Windows AIK\Tools\PETools\x86\winpe.wim. 

or  

Specify path to a folder with Win PE 2.0 unpacked files.   

3. Specify the full path to the resulting file including the file name. 

The builder will create a .WIM file if the source is WINPE.WIM. 

You can choose whether to create .WIM or .ISO file if the source is the folder. Choose .WIM if you are 
going to upload the PE image to the PXE server. Choose .ISO if you are going to put the PE image on 
physical media. 

4. Check your settings in the summary screen and click Proceed. 

5. Burn the .ISO to DVD using a third-party tool or copy to a flash drive. For how to upload the .WIM 
to ManageEngine PXE Server, see the next section. 

 
 

15.2  Uploading PE images to ManageEngine PXE Server 
 
You can upload to ManageEngine PXE Server either PE 1.0 .ISO or PE 2.0 .WIM.  
 
To be able to upload a PE 1.0 ISO, copy the I386 folder from your Windows distribution CD to the 
hard disk. 
 
1. Start ManageEngine OS Deployer Management Console 

2. Click Configure PXE Server 

3. Connect to the server 

4. Click Upload PE to PXE Server 

5. Do one of the following: 

Specify path to PE 1.0 .ISO file to upload 

or  

Specify path to PE 2.0 .WIM file to upload 

The Start automatically after parameter specifies the timeout interval for the boot menu. If 
not specified, the ManageEngine loader will display the boot menu and wait for someone to 
select whether to boot the OS or the PE. If you set, say, 10 sec, the PE will start 10 seconds 
after the menu is displayed. This enables unattended operation on the target side. 

 
6. Do one of the following, depending on your choice in step 5: 

Specify path to the I386 folder  

or  

Specify path to the Windows AIK folder 

7. Check your settings in the summary screen and click Proceed. 
 
 

 

A PE image based on Win PE 2.0 requires at least 256MB RAM to work. The recommended 
memory size for PE 2.0 is 512MB. 
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15.3  ASD command line syntax 
 

15.3.1  Supported commands 
 
ManageEngine OS Deployer command line utility has the following format: 
 
asdcmd /command /option1 /option2… 
 
Commands may be accompanied with options. Some options are common for most asdcmd 
commands, while others are specific for individual commands. Below is a list of supported commands 
and compatible options.  
 
 

Command Common Options Specific Options 

create 
Creates an image of 
specified disks and 
partitions 

/filename:[file name] 
/password:[password] 
/net_user:[username] 
/net_password:[password] 
/incremental 
/differential 
/compression:[0…9] 
/split:[size in MB] 
/oss_numbers /reboot 
/log:[file name] 
/log_net_user:[remote 
user] 
/log_net_password:[passwo
rd] 

/harddisk:[disk number] 
/partition:[partition number] 
/file_partition:[partition 
letter] /raw 
/progress:[on|off] 

deploy 
Deploys disks and 
partitions, including 
the MBR, from an 
image  

/filename:[file name] 
/password:[password] 
/net_user:[username] 
/net_password:[password] 
/oss_numbers /reboot 
/log:[file name] 
/log_net_user:[remote 
user] 
/log_net_password:[passwo
rd] 

/harddisk:[disk number] 
/partition:[partition number] 
/target_harddisk:[disk number] 
/target_partition:[partition 
number] /start:[start sector] 
/fat16_32 /size:[partition 
size in sectors] 
/type:[active|primary|logical] 
/preserve_mbr 
/license_server:[the server 
IP] /grant_server_license 
 
When using the ManageEngine Universal 
Deploy add-on: 
/ud_path:[path] 
/ud_username:[user] 
/ud_password:[pwd] 
/ud_driver:[inf-filename]  
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verify 
Verifies the image 
integrity 

/filename:[file name] 
/password:[password] 
/net_user:[username] 
/net_password:[password] 
/reboot /log:[file name] 
/log_net_user:[remote 
user] 
/log_net_password:[passwo
rd] 

 

list 
Lists available drives 
and partitions. With 
the filename option; 
lists the image 
contents 

/password:[password] 
/net_user:[username] 
/net_password:[password]  

/filename:[file name] 

15.3.2  Common options (options common for most asdcmd commands) 
 

Option Description Image location 

Access to images 
/filename:[file name] Full path to the image including the file 

name 
Any 

/password:[password] The password for the image (if 
required) 

Any 

/net_user:[username] Specify a user name for network drive 
access 

Network drive 

/net_password:[password] Specify a password for network drive 
access 

Network drive 

Imaging options 
/incremental Set the image type to incremental. If 

not specified or there is no basic full 
image, a full image will be created 

Any 

/differential Set the image type to differential. If not 
specified or there is no basic full image, 
a full image will be created 

Any 

/compression:[0…9] Specify the data compression level. It 
ranges from 0 to 9 and is set to 3 by 
default 

Any 

/split:[size in MB] Split the image into parts of the 
specified size 

 

General options 
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/oss_numbers Declares that numbers of partitions in 
the /partition option are adjusted 
for the MBR partition table, rather than 
just as ascending numbers. This means 
that primary partitions have numbers 1-
1, 1-2, 1-3, 1-4; logical partitions 
numbers start with 1-5. For example, if 
the disk has one primary and two 
logical partitions, their numbers can 
appear as follows: 
/partition:1-1,1-2,1-3 or 
/oss_numbers /partition:1-
1,1-5,1-6 

Any 

/reboot Reboot the computer after the 
operation is completed 

Any 

/log:[file name] Create a log file of the current operation 
with the specified file name 

Any 

/log_net_user:[remote user] If the log file is created on a network 
share, include the user name for logon 
to the share 

Any 

/log_net_password:[password] If the log file is created on a network 
share, include the password for logon to 
the share 

Any 

 
 
 

15.3.3  Specific options (options specific for individual asdcmd 
commands) 
 

Option Description 

create 
/harddisk:[disk number] Specifies the hard disks to include into the image file. The list of 

available hard disks is provided by the /list command. An image 
may contain data of more than one hard disk. In that case, 
separate disk numbers by commas, e.g.: 
 /harddisk:1,3 

/partition:[partition 
number] 

Specifies the partitions to include into the image file. The list of 
available partitions is provided by /list. Partition numbers are 
specified as <disk number>-<partition number>, e.g.: 
 /partition:1-1,1-2,3-1 

/raw Use this option to create an image of a disk (partition) with an 
unrecognized or unsupported file system. This will copy all 
disk/partition contents sector-by-sector. Without this option only the 
sectors containing useful system and user data are imaged (for the 
supported file systems). 
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/progress:[on | off] Shows/hides the progress information (percent completed). The 
progress is shown by default. 

deploy 
/harddisk:[disk number] Specifies the hard disk in the image. 

/partition:[partition 
number] 

Specifies the partitions in the image. 

/target_harddisk:[disk 
number] 

Specifies the target hard disk by number.  

/target_partition:[part
ition number] 

Specifies the target partition number for deploying a partition over 
the existing one. If the option is not specified, the program assumes 
that the target partition number is the same as the partition number 
specified with the /partition option. 

/start:[start sector] Sets the start sector for restoring a partition to the unallocated 
space on the hard disk. 

/size:[partition size 
in sectors] 

Sets the new partition size (in sectors). 

/fat16_32 Enables the file system conversion from FAT16 to FAT32 if the 
partition size after deployment is likely to exceed 2GB. Without this 
option, the deployed partition will inherit the file system from the 
image. 

/restore_bootable:[auto
:on:off] 

Sets the rule of MBR deployment when deploying a partition (when 
deploying a disk, MBR is always deployed.)  
Auto – deploy MBR, if an active partition that contains an operating 
system is deployed. Use this to ensure that the OS can boot up. 
On - deploy MBR, if an active partition is deployed, no matter 
whether the partition contains an OS or not. 
Off – do not deploy MBR. Use this to preserve the Unix loader, for 
example. 

/type:[active | primary 
| logical] 

Sets the deployed partition to active, primary or logical, if possible 
(for example, there cannot be more than four primary partitions on 
the disk.) Setting a partition to active always sets it to primary, 
while a partition set to primary may stay inactive.  
If the type is not specified, the program tries to keep the target 
partition type. If the target partition is active, the deployed partition 
is set to active. If the target partition is primary, and there are other 
primary partitions on the disk, one of them will be set to active, 
while the deployed partition becomes primary. If no other primary 
partitions remain on the disk, the deployed partition is set to active. 
When deploying a partition on unallocated space, the program 
extracts the partition type from the image. For the primary 
partition, the type will be set as follows: 
- if the target disk is the 1st according to BIOS and it has no other 
primary partitions, the deployed partition will be set to active 
- if the target disk is the 1st according to BIOS and there are other 
primary partitions on it, the deployed partition will be set to logical 
- if the target disk is not the 1st, the deployed partition will be set 
to logical. 
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/preserve_mbr When deploying a partition over an existing one, the target partition 
is deleted from the disk along with its entry in the target disk MBR. 
Then, with the /preserve_mbr option, the deployed partition’s 
entry will occupy the upper empty position in the target disk MBR. 
Thus, the target disk MBR is preserved. If not specified, the 
deployed partition’s entry will occupy the same position as in the 
source disk MBR saved in the image. If the position is not empty, 
the existing entry will be moved to another position. 

/patching_sid Generate the unique security identifier (SID) for the target 
computer. If not specified, the SID of the master system will be 
preserved. 

/license_server:[the 
server IP] 

Specifies the license server if the PE was booted from the PXE 
server. 

/grant_server_license Permits to take a server product license for deploying a workstation 
operating system (if the PE was booted from PXE server.) 

To use the following options you must have the ManageEngine Universal Deploy add-on in your PE. 
Also, the ManageEngine License Server must be accessible from the computer booted into the PE. For 
more information see 2.5  What is ManageEngine Universal Deploy. 

/ud_path:[path] 
/ud_username:[user] 
/ud_password:[pwd] 

Specifies using ManageEngine Universal Deploy and the path to the 
drivers storage. 

/ud_driver:[inf-filename] Specifies using ManageEngine Universal Deploy and the mass-
storage driver to be installed. 

list 
/filename:[file_name] With this option, the image content is displayed.  

When listing image content, partition numbers may not coincide 
with those in the drives/partitions list, if the image does not contain 
all the disk partitions. For example, if the image contains partitions 
2-3 and 2-5, they will be listed as 2-1 and 2-2.  
If the deploy /partition command cannot find a partition in 
the image by its physical number, use the /partition:<number 
in the image> /target_partition:<physical number 
of the target partition> keys. For the above example, to 
deploy partition 2-5 to its original place use: 
/partition:2-2 /target partition:2-5. 

 
 

15.3.4  asdcmd usage examples 
 
asdcmd /create /harddisk:1 /filename:\\server1\folder\arc.tib 
/net_user:user1 /net_password:pw1 /log:\\server2\dir\log1.log 
/log_net_user:user2 /log_net_password:pw2 
 
This will create an image arc.tib of hard disk 1 in the shared folder \\server1\folder. The operation log 
file log1.log will be saved on another share \\server2\dir\. Credentials for both shares are provided. 
 
asdcmd /create /filename:h:\raw.tib /partition:1-2 /raw /log5.txt 
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This will image partition 1-2 sector-by-sector (raw) and save the image on partition H. 
 
asdcmd /deploy /filename:\\server1\folder\1.tib /password:qwerty 
/harddisk:2 
 
This will deploy hard disk 2 from the password-protected image 1.tib located in the shared folder 
\\server1\folder to the disk with the same number 2. 
 
 

15.4  Sample scenarios 

15.4.1  Deploying images assigned to targets 
 
Scenario: 

An administrator might need to deploy diverse images on each of the target computers. 
 
Solution: 

The administrator puts the images in a shared location that can be accessed from each target.  
 
The administrator renames each image according to the target’s MAC address. The image 
destined to the computer with MAC address 01-02-03-04-05-06 will have the name, say, 
image-01-02-03-04-05-06.tib. 
 
The administrator writes a deployment script that can read the target’s MAC address and pull 
an image with a name corresponding to the MAC address from the shared location. The script 
can be executed on any number of targets.  

 
Sample script: 
 
setlocal 
SET IMG_PATH=\\image_server\images 
SET TMP_DRV_LETTER=h: 
 
net use %TMP_DRV_LETTER% %IMG_PATH% 
echo off 
for /f "tokens=1-13 delims= " %%a in ('ipconfig /all') do ( 
IF %%a EQU Physical ( 
for /f "tokens=1-3 delims= " %%a in ('echo %%l') do ( 
IF EXIST %TMP_DRV_LETTER%\%%a.tib ( 
echo DEPLOYMENT IMAGE file: %%a.tib 
asdcmd.exe /deploy /filename:%TMP_DRV_LETTER%\%%a.tib /harddisk:1 
/target_partition:c 
goto end 
) ELSE ( 
echo THE IMAGE FILE %IMG_PATH%\%%a.tib NOT FOUND 
) 
) 
) 
) 
:end 
echo on 
net use %TMP_DRV_LETTER% /d 
wpeutil Reboot 
endlocal 
 
 
What this script does:  
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Mounts the shared folder containing the set of images (one image corresponds to one target.)  
Retrieves the target’s MAC address.  
Generates a TIB file name (if MAC address is 01-02-03-04-05-06 then the TIB file name must be 01-
02-03-04-05-06.tib.)  
Searches the shared folder for an image with such name.  
Deploys the image if found.  
[OPTIONAL] Reboots or shutdowns the target.  
 
Environment variables:  
SET IMG_PATH – path to a shared folder on the deploy server.  
SET TMP_DRV_- mounted drive on target side. 
 
 
 
 

15.4.2  Creating images assigned to targets 
 
Scenario: 

The administrator might need to deploy on a computer a previously created image of the same 
system, to roll back the system to the imaged state. 

 
Solution: 

The administrator creates a script that images the computers and names each image 
according to the computer’s MAC address. The images can be deployed to the corresponding 
targets as described in the previous section.  

 
 
 
Sample script: 
 
setlocal 
SET IMG_PATH=\\image_server\images 
SET TMP_DRV_LETTER=h: 
 
net use %TMP_DRV_LETTER% %IMG_PATH% 
echo off 
for /f "tokens=1-13 delims= " %%a in ('ipconfig /all') do ( 
IF %%a EQU Physical ( 
for /f "tokens=1-3 delims= " %%a in ('echo %%l') do ( 
echo IMAGE FILE: %%a.tib 
asdcmd.exe /create /filename:%TMP_DRV_LETTER%\%%a.tib /harddisk:1 
/compression:8 
goto end 
) 
) 
) 
:end 
echo on 
net use %TMP_DRV_LETTER% /d 
wpeutil Reboot 
endlocal 
 
 
What this script does:  
 
Mounts the shared folder  
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Retrieves the booted computer’s MAC address.  
Generates a TIB file name (if MAC address is 01-02-03-04-05-06 then the TIB file name must be 01-
02-03-04-05-06.tib.)  
Images partition C of the computer to the shared folder using the generated file name.  
[OPTIONAL] Reboots or shutdowns the computer.  
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16.  Managing a remote computer 
 

16.1  File management on a remote computer 
 
The following operations with files and folders are available on remote computers through 
ManageEngine OS Deployer Management Agent:  

- creating and editing text files (for example batch files or scripts) 
- copying to the clipboard 
- pasting from the clipboard  
- renaming 
- deletion. 

 
1. Install the ManageEngine OS Deployer Management Agent on the managed machine. 

2. Connect the console to the managed machine. 

3. Select Manage files from the list of operations. 

4. Use the toolbar buttons or context menu to perform operations. 

 

 
 

File management 
 
Create new text file 
Select the target folder -> Create new text document -> Type in the new file name -> OK. 
 
Edit file 
Select the file -> Edit. 
The file will be opened with the associated editor. The file will be opened with Windows Notepad, if 
the file type is not associated with any editor. 
 
Create folder 
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Select the target folder -> Create new folder -> Type in the new folder name -> OK. 
 
Copy file or folder to clipboard 
Select the file or folder -> Copy. 
You can copy files and folders on the remote computer and paste them to your local machine and vice 
versa. 
 
Paste file or folder from clipboard 
Select the target directory -> Paste. 
 
Rename file or folder 
Select the file or folder -> Rename -> Enter new name -> OK. 
 
Delete file or folder 
Select the file or folder -> Delete -> OK. 
 

16.2  Executing applications on a remote computer 
 
You can schedule execution of service applications such as batch files or scripts on a remote machine 
through ManageEngine OS Deployer Management Agent. The purpose of running applications is to 
make changes to the deployed system. The applications run silently in the background, so please do 
not try to run applications such as Explorer, Notepad or any other application that has the user 
interface. 
 
For example, you can execute the Movefile.bat file, which contains the following commands: 

mkdir c:\Folder 
copy c:\Somefile.txt c:\Folder 
del c:\Somefile.txt  

This will create the new folder \Folder and place the Somefile.txt file into the folder. 
 
1. Install the ManageEngine OS Deployer Management Agent on the managed machine. 
2. Connect the console to the managed machine. 
3. Select Run application from the list of operations. 
4. Click Create new scheduled task to launch the wizard. 
5. Select the application. 
6. Select the task start parameters. 
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Start parameters 

 
Manually later – the task will be saved, but not launched automatically. You will be able to launch it 
later 
One time only – the task will be executed once at the specified time and date 
Upon event: 

 
 

Application can be executed on event 
 
An application can be executed at system startup or shutdown, at user logon or logoff or when free 
space on any internal hard disk either increases or decreases by the specified value. The preset is 
20MB. 
 
After the specified period of time elapsed: 
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Set the time interval between executing application 
 
Daily – the task will be executed once a day or once in several days 
Weekly – the task will be executed once a week or once in several weeks on the selected day 
Monthly – the task will be executed once a month on the selected day 
 
7. Specify the name of the user who owns the executed task. 
 
8. Check your settings in the summary screen and click Finish. 

Once the task is scheduled, you can access it at any time in order to edit the task or view the task’s 
results. To do so, connect to the managed machine and select Run application.  
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Executing application is scheduled 
 
You can run, edit, rename or delete the task using the toolbar buttons. 
 
Editing is performed in the same way as creation, however, the earlier selected options will be set, so 
you only have to enter the changes.  
 
Deleting or editing a task does not affect the current task execution. A task, that has been edited or 
deleted while running, will come to an end without any changes. The changes you made will be 
applied when execution is completed. 
 
To run the task immediately, click Execute selected task now. The task schedule remains valid. 
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